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Unified Messaging with OpenScape Xpressions

Overview
1  Unified Messaging with OpenScape Xpressions

1.1  Overview

OpenScape Xpressions is a mail server for unified messaging. OpenScape 
Xpressions integrates all mail services for voicemail, fax, e-mail and short 
messages (SMS). Only one non-service-specific mailbox is set up for every user 
and for all these services. This means, all messages are stored in one mailbox 
independent from the service they were sent by. Each user can be assigned a 
personal e-mail address and a personal fax number for receiving mails in this 
mailbox. His/her telephone number is a valid address, too, so that voice mails can 
be deposited in his/her mailbox.

You can access this mailbox via any networked PC or via any telephone at your 
workplace. The mailbox can be maintained from any telephone or any PC with 
internet access. Each subscriber can be informed about the arrival of a new 
message by a notification. Such notifications are possible

• on the workstation telephone, via the mailbox LED or as acoustic indication,

• on and arbitrary external telephone,

• on a cell phone by SMS, or

• via a pager.

The OpenScape Xpressions server can be used as a mailbox server or as a 
gateway to other mail systems. Connections to Microsoft Exchange Server or 
Lotus Notes are feasible as gateway server. If configured, all required 
conversions of different document formats take place on the OpenScape 
Xpressions server. This means that incoming messages of a particular service 
can be forwarded to other services if the data conversion process is feasible. The 
following data conversions are permitted, for example:

• Text-to-Speech (TTS)

• MS-Office documents (Word, Excel, PowerPoint) to fax

• Postscript to fax

• Fax to different graphics formats (JPG, TIF, BMP, DCX)

Separate service-specific addresses or numbers can be defined for every 
mailbox.
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Differences Between E-Mail, Voice Mail and Fax Mail
1.2  Differences Between E-Mail, Voice Mail and Fax Mail

All messages stored on the OpenScape Xpressions server are generally e-mails. 
Your e-mail client, therefore, displays all messages as e-mail messages. All voice 
or fax messages are provided as attachments to the e-mail. The purpose of the 
telephone access facility to your mailbox, however, is to distribute all messages 
according to the service. E-mail messages that only comprise an audio 
attachment are displayed as voice mails, and messages that only comprise an 
image attachment are displayed as fax messages. In special configurations you 
can extend the standard Microsoft Outlook features also for Microsoft Outlook 
2003, Microsoft Outlook 2007 or Microsoft Outlook 2010 by installing special 
forms (see the Microsoft Outlook Extensions manual):

Via the forms it is possible to

• flag voice mails and fax messages in the Outlook journals by special symbols

• transmit fax, SMS and voice messages as well as poll fax messages (fax-on-
demand)

• view or play and edit incoming fax and voice messages.

1.3  User Manual Client Applications

This document compiles and describes all client applications available for 
operating the communication functions provided by the OpenScape Xpressions 
server. Those client applications are dealt with in detail that, owing to their 
relatively small functional scope, are not subject of an individual manual. For all 
other client applications you find here a short function overview and a reference 
to the associated manual.

This manual supports you in using your mailbox, if you do not use any of the client 
programs shipped with OpenScape Xpressions by default for editing your 
mailbox. The operation of the programs used will be explained on the basis of the 
entry dialogs.

NOTE: Depending on the operating system (Windows XP Professional, 
Windows 2003, Windows Vista Business, Windows Vista Enterprise or Windows 
7), the screen resolution and the PC configuration, the representation may slightly 
deviate.
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User Manual Client Applications
It tells you:

• which settings you should make on your telephone/PBX (see Section 1.4, 
“Preparations on your Telephone and PBX”, on page 14).

• which clients are available for operating your mailbox.

• how to edit received messages on a PC.

– at your workstation: see Section 2.7, “Netscape Communicator”, on page 
24, Section 2.8, “Microsoft Outlook Express”, on page 27, Section 2.9, 
“Microsoft Outlook in Internet Mail Operation”, on page 33. The Microsoft 
Outlook Extensions manual describes how to operate the Microsoft 
Outlook extensions. The Lotus Notes Extensions manual describes how 
to operate the Notes Extensions. 

– at an arbitrarily networked PC: see Section 2.7, “Netscape 
Communicator”, on page 24, Section 2.8, “Microsoft Outlook Express”, on 
page 27, as well as Section 2.9, “Microsoft Outlook in Internet Mail 
Operation”, on page 33.

• how to send e-mails: see Chapter 2, “Mailbox Editing on the PC and E-Mail 
Service”.

• which CTI clients are available for operating your telephone. See Chapter 3, 
“CTI Clients for Telephone Operation”.

• how to schedule, use and control voice and/or web conferences. See Chapter 
4, “The Conference Extension for Microsoft Outlook and Lotus Notes”.

• how to send faxes: see Chapter 5, “Fax Mail Service”.

• how to send short messages (SMS): see Chapter 6, “Short Message 
Service”.

• which telephone user interfaces are available for editing your mailbox. See 
Chapter 7, “OpenScape Xpressions Voice Mail Systems”.

• how to view respectively listen to fax and voicemails with the client CyViewer: 
see Chapter 8, “CyViewer”.

• how to record telephone calls, provided you have the corresponding user 
privilege: see Chapter 9, “Conversation Recorder”.

• how to use the Caller Guide to establish with this connection wizard an 
internal phone connection either voice- or entry-controlled: see Chapter 10, 
“Caller Guide”.

• how to use the MAPI fax printer driver for creating fax messages. See 
Chapter 12, “MAPI Fax Printer Driver”.

• the Service Provider (MSP) function. See Chapter 13, “Service Provider 
(MSP)”.
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• the MSP TAPI Service Provider (MSPTSP) function. See Chapter 14, “MSP 
TAPI Service Provider (MSPTSP)”.

The following client applications are available for operating the OpenScape 
Xpressions server features:

OpenScape Xpressions 
Client

Manual Reference

Outlook Forms for sending 
fax, SMS and voice 
messages as well as for fax 
polling and editing incoming 
fax and voice messages.

See Section 2.1, “Microsoft Outlook in Exchange 
Operation”, on page 20.
Operation is described in the Microsoft Outlook Extensions 
manual.

optiClient 130 See Section 3.2, “OpenScape Xpressions optiClient 130”, 
on page 41. The optiClient 130 manual is available as user 
guide.

OpenScape web client See Section 3.3, “OpenScape Web Client”, on page 43. 
The client's operation is described in the OpenScape Web 
Client manual.

Conference extension for 
Microsoft Outlook and 
Lotus Notes

See Section 4.1, “The Conference Extension”, on page 45. 
Operation is described in the manuals Microsoft Outlook 
Extensions or Lotus Notes Extensions.

Outlook Forms with 
connection to an SMTP 
server

See Section 2.2, “Microsoft Outlook at an SMTP Server”, 
on page 21. Operation is described in the Microsoft Outlook 
Extensions manual.

Lotus Notes Extensions See Section 2.3, “Lotus Notes”, on page 22. Operation is 
described in the Lotus Notes Extensions manual.

Communications See Section 2.4, “Communications”, on page 22. Operation 
is described in the Communications manual.

Web Assistant See Section 2.5, “Web Assistant”, on page 23. Operation is 
described in the Web Assistant manual.

IP Phone Assistant See Section 2.6, “OpenScape Xpressions IP Phone 
Assistant”, on page 23. How to operate this client 
application is described in the IP Phone Assistant manual.

Ergo See Section 7.1, “Ergo”, on page 63. Operation is 
described in the Ergo manual.

Evo See Section 7.2, “Evo”, on page 64. Operation is described 
in the Evo manual.

OpenScape Xpressions 
PhoneMail

See Section 7.3, “OpenScape Xpressions PhoneMail”, on 
page 67. Operation is described in the OpenScape 
Xpressions PhoneMail manual.

OpenScape Xpressions 
VMS

See Section 7.4, “OpenScape Xpressions VMS”, on page 
68. Operation is described in the OpenScape Xpressions 
VMS manual.

Netscape Communicator See Section 2.7, “Netscape Communicator”, on page 24.

Microsoft Outlook Express See Section 2.8, “Microsoft Outlook Express”, on page 27.

Microsoft Outlook See Section 2.9, “Microsoft Outlook in Internet Mail 
Operation”, on page 33.
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CyViewer See Chapter 8, “CyViewer”.

Conversation Recorder See Chapter 9, “Conversation Recorder”.

Caller Guide See Chapter 10, “Caller Guide”.

MAPI Fax Printer Driver See Chapter 12, “MAPI Fax Printer Driver”.

Service provider See Chapter 13, “Service Provider (MSP)”.

TAPI Service Provider See Chapter 14, “MSP TAPI Service Provider (MSPTSP)”.

Application Builder See Chapter 15, “Application Builder”. The operation is 
described in the Application Builder manual.

OpenScape Xpressions 
Client

Manual Reference
A31003-S2370-U100-3-7619, 11/2013
OpenScape Xpressions V7 Client Applications, User Guide 13

          



Unified Messaging with OpenScape Xpressions

um_ba.fm

Preparations on your Telephone and PBX
1.4  Preparations on your Telephone and PBX

For the optimum use of your mailbox, set the call forwarding or CFNR function for 
the voice and fax services. Voice or fax calls to your extension will then be 
forwarded to your OpenScape Xpressions mailbox. Please refer to the operating 
instructions for your telephone or PBX for information on how to set up these 
functions. Your system administrator will tell you which numbers you must set as 
the call forwarding destination.

1.5  User-specific Data

This section provides you with an overview of all important user-specific or 
system-specific data. You will always have an overview of all important settings 
at hand if you note down all of the relevant data here. Your system administrator 
will give you the information you need.

1.5.1  Telephone System Data

Number for call forwarding, voice 
service
= service access number for forward 
access

Number for call forwarding, fax service
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1.5.2  Data for Telephone Access via Ergo

Dial individual mailbox
= service access number for the 
control mode (direct access)

Dial foreign mailbox
= service access number for the 
answering machine mode (guest 
access) with message recording only.

Dial foreign mailbox
= service access number for the 
answering machine mode (guest 
access) with message assistant only.

Service access number for the 
express mode
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1.5.3  Data for Telephone Access via Evo

1.5.4  Data for Telephone Access via PhoneMail

Dial individual mailbox
= service access number for the 
control mode (direct access)

Dial foreign mailbox
= service access number for the 
answering machine mode (guest 
access) with message recording only.

Dial foreign mailbox
= service access number for the 
answering machine mode (guest 
access) with message assistant only.

Dial own mailbox
= service access number for direct 
access

Dial external mailbox
= service access number for guest 
access

Service access number for callback 
access

Service access number for universal 
access
 A31003-S2370-U100-3-7619, 11/2013
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1.5.5  Data for Telephone Access via VMS

You can change your password for telephone access to the mailbox. You should 
not write down this password in the interests of security.

Dial own mailbox
= service access number for direct 
access

Dial external mailbox
= service access number for guest 
access

Service access number for callback 
access

Service access number for universal 
access
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1.5.6  Data for PC Access

Furthermore, you need your password to access the PC. The system 
administration will tell you the password for the initial logon. After the initial logon, 
please immediately change this password, so that only you can log on to the 
system. In doing so, please heed the guidelines for passwords given by the 
system administration.
For your own interest you should never note down your password.

User name of the XPR subscriber

E-mail address for the XPR mailbox

XPR server name

IP address of the XPR server

Domain address of the XPR server

Server name for the inbox/incoming 
mail
(this can be identical to the domain 
address)

Server name for the outbox/outgoing 
mail
(this can be identical to the inbox)

URL of the Web Assistant

XPR address book URL for importing 
mail clients
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2  Mailbox Editing on the PC and E-Mail Service

This chapter describes the PC access to your OpenScape Xpressions mailbox. 
Using your PC, OpenScape Xpressions provides you with a uniform access 
interface to your voice messages, fax messages and e-mails.

You can generally use all e-mail clients that support an IMAP access. Though 
OpenScape Xpressions also masters the POP3 access, we do not recommend 
this access mode since it does not include mailbox synchronization when 
connected to the Lotus Domino or Microsoft Exchange server. PC access is 
described based on the following e-mail clients:

• Netscape Messenger (see Section 2.7, “Netscape Communicator”, on page 
24)

• Microsoft Outlook Express (see Section 2.8, “Microsoft Outlook Express”, on 
page 27)

• Microsoft Outlook in Internet mail operation (see Section 2.9, “Microsoft 
Outlook in Internet Mail Operation”, on page 33)

You can edit the OpenScape Xpressions mailbox also via the following client 
applications:

• Microsoft Outlook 2003, Microsoft Outlook 2007 and Microsoft Outlook 2010 
in connection with Microsoft Exchange Server (see the Microsoft Outlook 
Extensions) manual

• Microsoft Outlook 2003, Microsoft Outlook 2007 and Microsoft Outlook 2010 
in connection with an SMTP server (see the Microsoft Outlook Extensions) 
manual

• Lotus Notes (see the Lotus Notes Extensions manual

• Communications (see the Communications user manual)

• Web Assistant (see the Web Assistant manual)

NOTE: You can ask your system administrator for your personal OpenScape 
Xpressions user data that you require for mailbox editing on the PC.
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2.1  Microsoft Outlook in Exchange Operation

For Microsoft Outlook in Exchange operation you can install OpenScape 
Xpressions Outlook extensions. The following Microsoft Outlook extensions are 
available:

• Icon Forms

Via icon forms stored on the Exchange server, special icons are displayed in 
the Outlook message journals for the various message types (fax, voice mail 
etc.) instead of the default message icon (envelope).

• Message Forms

Via message forms, received fax and voice mail messages can be viewed 
respectively played and edited in addition. Further forms serve for sending 
fax, voice mail and SMS messages and for fax-on-demand. You can use the 
following features via message forms:

– Voice mail playback on the telephone

– Voice mail playback via the PC sound system

– Viewing and editing fax messages

– Sending voice mails to arbitrary subscribers

– Sending voice mails via a contact entry

– Answering any message with a voice annotation

– Sending voice mails via the Exchange address book

– Answering/forwarding voice messages with voice comments

– Sending SMS messages to any subscriber

– Sending SMS messages to a contact

– Sending SMS messages to the originator of a message

– Sending SMS messages to a cell phone from the Exchange address book

– Fax-on-demand

– Sending a fax message to any subscriber

– Sending a fax message to a contact

– Sending a fax message to the originator of a message

– Sending a fax message from the Exchange address book

– Sending a fax message from Microsoft Office applications

– Sending a fax message from Explorer
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– Answering/forwarding fax messages with annotations

– Invocation of the Web Assistant

• The conference extension that offers the following options via the Outlook 
feature Meeting Request:

– Scheduling and initiating telephone conferences

– Scheduling and initiating web conferences

– Scheduling and initiating combined telephone/web conferences

• OpenScape Xpressions optiClient 130

The CTI client can be directly reached from Outlook and provides the 
following features:

– Telephoning, conference, diverting etc.

– logging calls

– calling via Outlook entries

– Calling via contact entries

– identifying callers

– call scheduling

For further information about the operation of the Outlook Extensions please refer 
to the user manual Microsoft Outlook Extensions. For information about 
OpenScape Xpressions optiClient 130 see Section 3.2, “OpenScape Xpressions 
optiClient 130”, on page 41.

2.2  Microsoft Outlook at an SMTP Server

Message forms, the conference extension and OpenScape Xpressions optiClient 
130 are available for this operation mode also.
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2.3  Lotus Notes

OpenScape Xpressions extensions can be installed for Lotus Notes as well. The 
Lotus Notes mail extensions are provided with the Lotus Notes e-mail client. If 
you open the e-mail client, you can use the selected mail extension.

• Fax (mail extension to send fax messages),

• Fax-on-demand (mail extension to poll fax messages),

• SMS (mail extension to send SMS messages),

• Voice (mail extension for sending voice messages)

• Voicemail annotation (mail extension for answering/forwarding a message 
with a voice comment)

You find further information on operating the Lotus Notes extensions in the Lotus 
Notes Extensions user manual.

2.4  Communications

Communications is the central communication and administration program of the 
OpenScape Xpressions server. All communication processes that the user wants 
to initiate can be handled and monitored via Communications.

This client program enables the user to send and receive information from/on his/
her computer deploying various services such as SMS, Fax, , e-mail or Voicemail. 
If configured, telephony features for telephone operation and monitoring can be 
provided as well.

The administrator of the OpenScape Xpressions server is provided with the 
functions for user administration and configuring the OpenScape Xpressions 
server.

The Communications client is comprehensively described in the Communications 
user manual.
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2.5  Web Assistant

The Web Assistant is a convenient, browser-based application via which the 
OpenScape Xpressions system can be used, administered and configured.

By means of clearly structured HTML pages, all users of the OpenScape 
Xpressions system can create and administer messages of different types (e-
mail, fax, SMS and voice messages).

Furthermore, users can access the personal parameters of the message services 
provided by the OpenScape Xpressions system and customize them according 
to their personal requirements.

Comprehensive options for system administration and configuration are available 
to the OpenScape Xpressions system administrator via the Web Assistant.

The Web Assistant is comprehensively described in the Web Assistant user 
manual.

2.6  OpenScape Xpressions IP Phone Assistant

The IP Phone Assistant is a web-based client application used via telephone. 
With the IP Phone Assistant you can retrieve respectively play text messages, 
voicemails and greetings, record new greetings, and send SMS messages. 
Operating the IP Phone Assistant and using its functionality requires either the 
optiPoint application module or an OpenStage 60 respectively 80 as output 
device. How to operate this client application is described in the IP Phone 
Assistant manual.
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2.7  Netscape Communicator

The descriptions in this chapter are based on Netscape Communicator Version 
7.1.

2.7.1  System Requirements

• Netscape Communicator Version 7.1

• Your PC must be equipped with a sound card, microphone, loudspeakers/
headset and appropriate playback software to allow voice message 
processing on your PC.

• The relevant graphics software must be installed on your PC to allow fax 
messages to be viewed. A graphics format that is supported by the user’s 
graphics software can be set for each individual user.

2.7.2  Particularities with IMAP Operation under 
Netscape

• No directories may be created on the IMAP server. Therefore, the Move it to 
the Trash folder option in the Netscape client under When I delete a 
message: must not be activated, since in this case the Trash folder is 
created on the server. Select the Mark it as deleted option here instead. You 
find this option after opening the Settings context menu for the mail account 
and switching to the Server Settings dialog by doubleclick.

• To delete the message for good, execute the menu option File > Compact 
Folders in Netscape.

• Use exclusively local directories for messages that you may want to save 
from the inbox. Click on the Save as command for this purpose.

2.7.3  Setting up an Account in Netscape

You access your OpenScape Xpressions mailbox with the Netscape 
Communicator via an e-mail account (profile) configured in the Netscape 
Communicator. With a configured profile you can address a mailbox on a mail 
server. You must create a separate profile for every mail server if you are using a 
number of mail servers.

1. Start Netscape Navigator. In the File > New menu select the Message item.

Since there is not yet an e-mail account, the New Account Setup window 
appears.
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2. Select E-mail account and click Next.

3. Enter the corresponding data in the Your Name and your Email Address 
fields of the Identity dialog. Confirm the entries by clicking Next.

4. In the Server Information window, specify the server type for incoming e-
mails (IMAP). In the Incoming Server and Outgoing Server fields, enter the 
names of the OpenScape Xpressions server for incoming and/or outgoing 
mail. Please consult your system administrator if you have any queries. Click 
on Next to continue configuring the e-mail account.

5. In the following dialog, under User Name, enter your OpenScape Xpressions 
user name and click on Next.

6. In the Account Name window, enter a meaningful name for the new e-mail 
account. Then click on Next. The following dialog displays the entries you 
have made for configuring the e-mail account, so that you can check them for 
correction.

7. If all entries are correct, confirm them with Finish. 

The account for accessing your OpenScape Xpressions mailbox is now set up.

If you need further information on configuring a new profile, please consult the 
Netscape Communicator description or the Netscape Communicator online help.

2.7.4  Receiving Messages with Netscape

Start Netscape Messenger to receive messages for the set up e-mail account. 
There are several ways to do this.

• via Start > All Programs > Netscape 7.1 > eMail & Newsgroups,

or when the Netscape Navigator has already been started

• via Window > Mail & Newsgroups 

• alternatively via the letter icon with the eMail link in the Netscape Navigator.

The password entry dialog opens then immediately. Enter your OpenScape 
Xpressions password.

The inbox opens and your messages are displayed once you have entered the 
correct password.
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All incoming messages are e-mail messages. You receive original voice and fax 
messages as additional data in the form of e-mail attachments.

An incoming voice message is attached to an e-mail as sound file. If you have 
entered the relevant link for this file type (WAV) in Netscape, clicking the audio file 
starts the selected player and you can listen to your voicemail.

An incoming fax message is attached to an e-mail as a graphics file. If you are 
using graphics software that is linked in Netscape to the file type of the 
attachment, the corresponding program will be opened when you click on the 
attachment with the graphics file, thus displaying the fax. The graphics file 
displays the fax. If JPG is set as the graphics format, Netscape Messenger will 
display the fax directly in the message window.

2.7.5  Sending Messages with Netscape

All messages that you create and send via Netscape Messenger are normal e-
mails. The OpenScape Xpressions server can route your e-mail message, fax 
message or short message to a distribution list, fax device or cell phone using a 
special addressing procedure.

2.7.5.1  Routing Messages to OpenScape Xpressions 
Distribution Lists 

The personal distribution lists defined using the Web Assistant and the public 
distribution lists provided by the system administrator can be entered as recipient 
addresses. For the correct addressing to a OpenScape Xpressions distribution 
list consult the Web Assistant manual.

2.7.5.2  Fax Messages

All e-mail messages that you send via the OpenScape Xpressions server to a fax 
address are received by the recipient as fax messages. Please refer to Chapter 
5, “Fax Mail Service” for information on the correct addressing of messages to fax 
addresses.

2.7.5.3  Routing Short Messages to a Mobile Telephone

All e-mail messages that you send via the OpenScape Xpressions server to an 
SMS address are received by the recipient as short messages. Please refer to 
Chapter 6, “Short Message Service” for information on the correct addressing of 
messages to SMS addresses.
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2.8  Microsoft Outlook Express

The descriptions in this chapter are based on Microsoft Outlook Express 
Version 6.

2.8.1  System Requirements

• Microsoft Outlook Express Version 6

• Your PC must be equipped with a sound card, microphone, loudspeakers/
headset and appropriate playback software to allow voice message 
processing on your PC.

• The relevant graphics software must be installed on your PC to allow fax 
messages to be viewed. A graphics format that is supported by the user’s 
graphics software can be set for each individual user.

2.8.2  IMAP Operation Particularities

• The Send and Receive function in Outlook Express Client does not work 
correctly. To update the inbox, you should briefly switch directories. The inbox 
is then completely updated. You should not use the Send/Recv button for 
inbox updating.

• If messages are deleted in the IMAP client, they are only marked as deleted. 
To remove a message for good, you need to execute the menu item Edit > 
Purge Deleted Messages in Outlook Express.
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2.8.3  Setting up an Account

Start Microsoft Outlook Express and select the Accounts... command in the 
Tools menu. Click Add in the Internet Accounts window and select Mail....

The Internet Connection Wizard is started. In the Name field enter the name to 
appear as e-mail originator at the receiving party.
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Enter your OpenScape Xpressions e-mail address in the next window.

Set the name of your incoming mail server to IMAP. Enter the OpenScape 
Xpressions server as the incoming and outgoing mail server.
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Enter your OpenScape Xpressions user name as IMAP account name. Enter 
your OpenScape Xpressions password as the password.

NOTE: Log on using Secure Password Authentication (SPA) is not 
supported.

The account for accessing your OpenScape Xpressions mailbox is now set up. 
Click on Finish.
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After configuring the account you can access the directories Inbox and Sent 
Items in Outlook Express under the account name.

NOTE: Depending on the language version of the installed mail server the 
names of the above folders may differ.

Further IMAP directories may be displayed if they are created by the mail system. 
For example, the “Draft” directory. However, these cannot be displayed with the 
account name and are thus not available for access. These folders are 
exclusively designated for the usage with other system components.

2.8.4  Receiving Messages

To receive messages for the configured e-mail account, start Outlook Express 
and switch to the inbox of your OpenScape Xpressions account.

All incoming messages are e-mail messages. You receive original voice and fax 
messages as additional data in the form of e-mail attachments.

An incoming voice message is attached to an e-mail as sound file. If you have 
entered a link for this file type (WAV), clicking the sound file starts the selected 
player and you can listen to your voicemail.

An incoming fax message is attached to an e-mail as a graphics file. If you are 
using graphics software that is linked to the file type of the attachment, the 
corresponding program is opened by clicking the attachment containing this file. 
The graphics file displays the fax. Outlook Express displays JPG files directly in 
the message window.
A31003-S2370-U100-3-7619, 11/2013
OpenScape Xpressions V7 Client Applications, User Guide 31

          



Mailbox Editing on the PC and E-Mail Service

clients_ba.fm

Microsoft Outlook Express
2.8.5  Sending Messages

All messages that you create and send using Microsoft Outlook Express are 
normal e-mail messages. The OpenScape Xpressions server can route your e-
mail message, fax message or short message to a distribution list, fax device or 
cell phone using a special addressing procedure.

2.8.5.1  Routing Messages to OpenScape Xpressions 
Distribution Lists

The personal distribution lists defined using the Web Assistant and the public 
distribution lists provided by the system administrator can be entered as recipient 
addresses. For the correct addressing to a OpenScape Xpressions distribution 
list consult the Web Assistant manual.

2.8.5.2  Fax message

All e-mail messages that you send via the OpenScape Xpressions server to a fax 
address are received by the recipient as fax messages. 

Please refer to Chapter 5, “Fax Mail Service” for information on the correct 
addressing of messages to fax addresses.

2.8.5.3  Routing Short Messages to a Cell Phone (SMS)

All e-mail messages that you send via the OpenScape Xpressions server to an 
SMS address are received by the recipient as short messages. Please refer to 
Section 6.2, “Sending short Messages”, on page 58 for information on the correct 
addressing of messages to SMS addresses.
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2.9  Microsoft Outlook in Internet Mail Operation

Deploying Microsoft Outlook 2003, Microsoft Outlook 2007 and Microsoft 
Outlook 2010 you can use internet mail operation via IMAP parallel to the 
Exchange connection.

2.9.1  System Requirements

• Microsoft Outlook 2003, Microsoft Outlook 2007 or Microsoft Outlook 2010.

• Your PC must be equipped with a sound card, microphone, loudspeakers/
headset and appropriate playback software to allow voice message 
processing on your PC.

• The relevant graphics software must be installed on your PC to allow fax 
messages to be viewed. A graphics format that is supported by the user’s 
graphics software can be set for each individual user.

2.9.2  IMAP Operation Particularities

• If messages are deleted in the IMAP client, they are only marked as deleted. 
To remove a message for good, you need to execute the menu item Edit > 
Purge Deleted Messages in Microsoft Outlook.

2.9.3  Setting up an Account

2.9.3.1  Starting Microsoft Outlook initially

When you start Microsoft Outlook after the installation for the first time, i.e. no 
Outlook profile has been created yet, execute the following steps to create a 
profile:

1. Invoke Start > E-mail (Microsoft Office Outlook) from the start menu. The 
start dialog for the Outlook configuration opens.
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2. Click the Next button. The E-mail Accounts dialog opens.

Select the Yes option here to set up an e-mail account. After a click on Finish 
the Server Type dialog opens. The description of the next configuration 
procedures is given from work step 6 in the following chapter.

2.9.3.2  Configuring an additional Outlook Profile for the IMAP 
Operation

If you have already created an Outlook profile, for example to operate Microsoft 
Outlook at a Microsoft Exchange Server, proceed as follows to configure another 
profile for IMAP operation:

1. Start the Microsoft Outlook profile administration via Start > Control Panel > 
Mail. The Mail Setup - Outlook dialog opens.

2. Click the Show Profiles button here. The Mail dialog opens.
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3. Select the Prompt for a profile to be used option here. This enables you to 
select a profile from the existing ones at each Microsoft Outlook start. Then 
click Add.... The New Profile dialog opens for you to enter the profile name.

4. Assign a meaningful name to the IMAP profile so that you can quickly 
recognize it. Accomplish the name entry with OK. A wizard starts to support 
you in setting up and editing e-mail accounts.

5. In the E-mail Accounts dialog select the Add a new e-mail account option 
and click on Next. The dialog for defining the server type opens.
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6. In this dialog you define which server type you want to use for your e-mail 
account. Select the IMAP option here and click on Next. You are now taken 
to the configuration dialog for the e-mail settings.

7. In the User Information fields Your Name and E-mail Address specify your 
name and your OpenScape Xpressions e-mail address. In the Server 
Information portion enter the network address of the incoming-mail server 
(IMAP) and outgoing-mail server (SMTP). In our case, enter here the IP 
address of the OpenScape Xpressions server respectively. If you do not know 
this address, please consult your administrator. For the Logon Information 
enter under User Name the OpenScape Xpressions logon name (tantamount 
to the user recognition or user ID), and under Password enter your 
OpenScape Xpressions password. Via the Remember password option you 
can define whether or not a user needs to authenticate himself/herself by 
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password entry at each Microsoft Outlook start. If you enable the option, thus 
save the password, Outlook will start without password query. After you have 
performed all settings, click Next.

8. A conclusive dialog confirms that you have made all required settings. Click 
Finish to configure the profile.

Profile configuration for IMAP operation is thus complete.

2.9.4  Receiving Messages

To receive messages for the configured e-mail account, start Microsoft Outlook 
and switch to the inbox of your OpenScape Xpressions account.

All incoming messages are e-mail messages. You receive original voice and fax 
messages as additional data in the form of e-mail attachments.

An incoming voice message is attached to an e-mail as sound file. If you have 
entered a link for this file type (WAV), clicking the sound file starts the selected 
player and you can listen to your voicemail.

An incoming fax message is attached to an e-mail as a graphics file. If you are 
using graphics software that is linked to the file type of the attachment, the 
corresponding program is opened by clicking the attachment containing this file.

2.9.5  Sending Messages

All messages that you create and send via Microsoft Outlook are normal e-mails. 
The OpenScape Xpressions server can route your e-mail to a distribution list, 
your fax to a fax device or your short message to a cell phone using a special 
addressing procedure.

2.9.5.1  Routing Messages to OpenScape Xpressions 
Distribution Lists

The personal distribution lists defined using the Web Assistant and the public 
distribution lists provided by the system administrator can be entered as recipient 
addresses. For the correct addressing to a OpenScape Xpressions distribution 
list consult the Web Assistant manual.
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2.9.5.2  Fax Message

All e-mail messages that you send via the OpenScape Xpressions server to a fax 
address are received by the recipient as fax messages. 

Please refer to Chapter 5, “Fax Mail Service” for information on the correct 
addressing of messages to fax addresses.

2.9.5.3  Routing Short Messages to a Cell Phone (SMS)

All e-mail messages that you send via the OpenScape Xpressions server to an 
SMS address are received by the recipient as short messages. Please refer to 
Chapter 6, “Short Message Service” for information on the correct addressing of 
messages to SMS addresses.
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3  CTI Clients for Telephone Operation

3.1  Versions

In the course of the OpenScape Xpressions server development, Microsoft 
Outlook and Lotus Notes extensions have been supplied with the product in 
different specifications and development stages. The CTI clients have always 
been elements of these extensions. The following variants have been used by 
customers with the different OpenScape Xpressions versions:

• With the version HiPath Xpressions 3.0

The HiPath Xpressions Outlook Extensions components (HXOE)

• With the version HiPath Xpressions 4.0

The HiPath Xpressions Extensions components (HXE) They comprise:

– The Outlook forms (icon and message forms)

– The message forms and the Simple Dialer for Lotus Notes

– SimplyPhone for Outlook Standard as CTI client with the following 
features:

• Calling via number entry

• Callback to selected journal entries

• Search Phone Partner

– SimplyPhone Advanced as CTI client with the full CTI functionality and 
integration in Microsoft Outlook and Lotus Notes

• With the version HiPath Xpressions 5.0

The optiClient extensions. They comprise:

– The Outlook forms (icon and message forms)

– The message forms and the Simple Dialer for Lotus Notes

– OpenScape Xpressions optiClient 130 as independent CTI client with 
optional integration in Microsoft Outlook and Lotus Notes

• With version OpenScape Xpressions 6

– The optiClient extensions. They comprise:

• The Outlook forms (icon and message forms)

• The message forms and the Simple Dialer for Lotus Notes
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• OpenScape Xpressions optiClient 130 as independent CTI client with 
optional integration in Microsoft Outlook and Lotus Notes

– Conference extension for Microsoft Outlook

– Conference extension for Lotus Notes

– OpenScape Web Client as browser-based CTI client.

If you require information about older components, please refer to the manuals 
composed for the corresponding versions. The installation of the client 
components is described in the Client Installations manual.
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3.2  OpenScape Xpressions optiClient 130 

NOTE: Please note the individual restrictions on the listed uses. You find more 
information about this in the OpenScape Xpressions optiClient 130 administrator 
documentation.

OpenScape Xpressions optiClient 130 is a high-performance CTI client. You can 
use OpenScape Xpressions optiClient 130 as follows.

• As efficient CTI client on an XPR server.
In this function you can use it to control your desk telephone from your 
PC.

• Or as softphone at an SIP communication system.

• As softphone at a HiPath 3000 or Hipath 4000.

In each of these configurations you can

• initiate telephone calls,

• accept telephone calls,

• utilize more complex telephony functions – such as switching telephone 
conferences.

OpenScape Xpressions optiClient 130 also supports you in:

• conveniently managing private contacts in the contact list,

• setting up phone connections the easy way via the team bar,

• connecting external address books – for example via LDAP,

• integrating OpenScape Xpressions optiClient 130 functions in Microsoft 
Outlook and/or Lotus Notes.

If you use OpenScape Xpressions optiClient 130 at an XPR server, you can 
deploy further special features. Among these are:

• OpenScape Xpressions optiClient 130-independent logging of successful 
and unsuccessful calls

• The presence function, which informs you about the availability of other 
users.

• Sending and receiving instant messages.

• Web conferences.
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If you use optiClient 130 as SIP softphone at an OpenScape Voice system, you 
can:

• conduct simple video connections and video conferences.

• use the above special XPR server features, if your optiClient 130 is 
connected to an XPR server in parallel.

Furthermore, the modular structure of OpenScape Xpressions optiClient 130 
enables you to customize the features and representation of the application.

OpenScape Xpressions optiClient 130 cannot only be used on individual user 
PCs. As CTI client, you can also deploy the program in a terminal server 
environment.

You find more detailed information about operating the CTI client optiClient 130 
in the optiClient 130 operating instructions.
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3.3  OpenScape Web Client

With the OpenScape Web Client you can use a CTI client that enables the 
following features via the intranet or internet.

The OpenScape Web Client offers a similar functional range as the optiClient 130 
desktop client.

The OpenScape Web Client is a fully developed communications control tool. 
With the OpenScape Web Client you can extensively handle and monitor your 
voice communication from your workstation. Employees who need to handle a lot 
of information can use the OpenScape web client to manage their 
communications flow and access security-relevant company resources in real 
time.

The OpenScape Web Client main features are:

• Initiating and managing calls 
OpenScape Xpressions provides various features, for example to initiate 
calls, join a conference and monitor the operating states of your 
communication devices.

• Scheduling and starting conferences 
Conveniently starting ad-hoc or meet-me conferences, starting and managing 
predefined conferences or scheduling future conferences.

• Creating and maintaining contact lists 
Managing contacts and checking whether a contact is available for voicemail, 
e-mail or instant messaging.

• Journal representation 
All incoming and outgoing calls can be displayed in the Journal (All Calls) 
journal. This also considers calls that arrived during your absence since the 
information about these calls is centrally kept on the server. In addition, the 
phone numbers transmitted with incoming calls are matched to numbers 
contained in your contact list and, if present, the name of the caller is 
displayed.

You find more detailed information about operating the OpenScape Web Client in 
the OpenScape Web Client user manual.
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The Conference Extension
4  The Conference Extension for Microsoft Outlook and 
Lotus Notes

4.1  The Conference Extension

The conference extension facilitates scheduling and monitoring conferences. It 
provides the following conference options:

• Scheduling and initiating a voice conference (telephone conference).

• Scheduling and initiating a web conference.

• Scheduling and initiating a combined voice/web conference.

• Monitoring a scheduled and initiated telephone conference via the 
OpenScape Web Client. 

4.1.1  General Information

After you have installed the conference extension in Microsoft Outlook and Lotus 
Notes, you are provided with the features for scheduling and initiating telephone 
and web conferences. 

• Conference extension for Microsoft Outlook 

The conference extension installed in Microsoft Outlook is indicated by the 
conference overview button then displayed in the Microsoft Outlook toolbar.

Via this button you immediately reach the Conferences dialog of the 
OpenScape Web Client. In this dialog you receive an overview of all 
scheduled telephone conferences and may make adjustments if required. 
Please obtain further information about editing conferences in the 
OpenScape Web Client from the OpenScape Web Client manual. 

• Conference extension for Lotus Notes 

The conference extension installed in Lotus Notes is indicated by the 
conference overview button then displayed in the Lotus Notes toolbar.

Via this button you immediately reach the Conferences dialog of the 
OpenScape Web Client. In this dialog you receive an overview of all 
scheduled telephone conferences and may make adjustments if required. 
Please obtain further information about editing conferences in the 
OpenScape Web Client from the OpenScape Web Client manual. 
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4.1.2  Conference Types

With the Microsoft Outlook conference extension you can configure the following 
conference types:

• Voice conferences 
This type of conferences is exclusively staged via telephone.

• Web conferences 
This type of conferences is exclusively staged using an internet connection. 
The web conference tool is used for this purpose. A web conference 
describes here the collective use of programs and documents during real-
time computer conferences. A web conference enables the conference 
participants to display each other's desktop if allowed by the user. In this way 
all other conference participants can see the same image, knowing what 
everybody is on about. Documents and the entire desktop can also be shared 
for editing. Using the additional features you can directly discuss and illustrate 
matters. These additional features include, for example, the chat and 
whiteboard function. In case of a web conference the location in which the 
conference participants are situated is irrelevant. You merely need a PC with 
internet access and possibly a telephone. This ensures a high degree of 
flexibility and saves expenses for long journeys, accommodation etc. Since 
all session data is transmitted encrypted (256-Bit-AES encryption), sensitive 
data can be transmitted as well. 

• Combined voice/web conference 
In case of this conference type, a voice conference is staged simultaneously 
to a web conference. This a web conference with voice connection.

How to operate the conference features for Microsoft Outlook is described in 
detail in the Microsoft Outlook Extensions manual. In the appendix of this manual 
you also find instructions for operating a web conference. 

How to operate the conference features for Lotus Notes is described in detail in 
the Lotus Notes Extensions manual. In the appendix of this manual you also find 
instructions for operating a web conference. 
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5  Fax Mail Service

5.1  Overview

The following options are available to fax mail users in OpenScape Xpressions, 
depending on how the system is configured.

• You can send and receive fax messages on your workstation using the default 
e-mail client. When you receive the fax, it appears as attached graphics file 
(TIF or JPG file) in an e-mail.

• You can retrieve and output fax messages on the telephone. Fax messages 
can be output using
a) a standard fax device,
b) a standard printer,
c) any fax machine.

5.1.1  Requirements for Sending a Fax

You can use the fax function via the OpenScape Xpressions server from any PC 
application that permits data to be directly sent to an e-mail recipient. This chapter 
exemplifies how to send files from the Microsoft Windows Explorer as fax via the 
OpenScape Xpressions server.

5.1.2  Requirements for Receiving a Fax

Please read Chapter 2, “Mailbox Editing on the PC and E-Mail Service” for 
information on receiving a fax with an e-mail client.

For fax message editing on the telephone either read the PhoneMail, VMS, Ergo 
or Evo manual depending on the installation.

5.1.3  Fax Stationery

Fax stationery consists of special fax send forms provided by your system 
administrator. On the fax stationery the text you wrote is automatically inserted in 
predefined sections.

Fax stationery may additionally contain graphic elements (e.g. a company logo, 
etc.). Moreover, it is possible to integrate wildcards for important send parameters 
(e.g. originator, recipient, send time, subject etc.) into the fax stationery. Sending 
the fax message sets such parameters automatically.
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If your system administration has provided a set of fax stationery, you may specify 
which fax stationery to use for your fax messages via the Web Assistant (see Web 
Assistant manual) or via the fax send forms in Microsoft Outlook.

This feature works only if your internet e-mail address in your mail client is the 
same as the SMTP address of your OpenScape Xpressions mailbox and if the 
conversion of text to fax format is performed on the server.

5.1.4  Fax Display

Incoming faxes are saved in OpenScape Xpressions in an internal fax format. 
This fax format can also be represented by Communications. If you want to 
display incoming faxes using another mail client, you need to select a suitable 
conversion. Your system administrator configures one of the graphics formats 
listed below as the default conversion format on your system. This format is 
globally valid. An additional viewer software may be required if the mail client 
used cannot display this graphic format. You can have the system administrator 
set a different graphics format specially for your mailbox to facilitate access via 
IMAP or POP3. You should always try to convert all mailbox data to the same 
graphics format since this places the least demands on the system.

The conversion process supports the following graphics formats:

Format Description

BMP Windows bitmap

BMP_COL Windows bitmap with trilinear grayscale interpolation

DCX Multi-page PCX format (standard Microsoft fax format)

JPG JPEG format with 9 grayscales

TIF One-page compressed TIF fax format

TIF_BMP Uncompressed TIF bitmap format

TG3 Multi-page compressed TIF fax format
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5.2  Sending Fax Messages

To send fax messages, proceed in exactly the same way as for sending an e-mail. 
The recipient address selected must be an SMTP address that the OpenScape 
Xpressions server can interpret as fax address to trigger fax sending accordingly. 
Please remember that not all file formats can be used to create a fax.

5.2.1  Sending Fax Messages from the Windows 
Explorer

Start the Explorer and select a file that you would like to send as a fax.

To do this, right-click the required file. The context menu of the selected file 
opens. From this menu select the Send To > Mail Recipient command. A 
different e-mail program can be started, depending on the links set. Microsoft 
Outlook is used in this example. Proceed in the same way for all other mail 
programs.

You can also explicitly open the mail program, enter your text in the program and 
send the text as a fax.

A window for creating a new message opens. The selected file is automatically 
inserted as an attachment. You must now enter the fax recipient in the form of an 
e-mail address:
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Enter the recipient’s address in the To... box.
Heed the following addressing rules:
– Enter the FAXG3/ prefix at the beginning of the address.
– Now enter the user’s number in the form <internal fax number> or <international 
fax number> by entering the <country code><area code><fax number> without 
using special characters such as blanks, plus signs or hyphens, and not in the 
form that you would use when dialing the number yourself.
– Append the @ character followed by the domain address of your OpenScape 
Xpressions server. Contact your system administrator to find out which domain 
address needs to be specified here.

For example FAXG3/37877@myserver.de or FAXG3/
498972237877@myserver.de

The OpenScape Xpressions server recognizes from this address that the 
message is to be routed to the recipient as a fax.

To send the message, click the Send button or open the File menu and select 
one of the send commands.

The subject line in a fax is only sent if the respective variable is defined in the fax 
stationery. However, the subject line continues to be used as a sort criterion in 
your Sent Items box.
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5.2.2  Sending a Fax at favorable Rates

All e-mail clients that allow setting the send job priority also allow creating fax jobs 
with a preset time delay, which in turn reduces charges. Among such clients you 
find for example Microsoft Outlook, Microsoft Outlook Express or Netscape 
Messenger. Just set the priority to Low or Very Low, and the fax will only be sent 
during the night. The exact send times are defined by your system administration 
and can be requested there.

5.2.3  Using Fax-on-Demand Services

You can use fax-on-demand services in all e-mail clients. Send a blank e-mail to 
the following address:
FAXG3REV/<fax-on-demand number>@<myserver.domain>

This fax-on-demand number must be entered in international format. The 
OpenScape Xpressions server then retrieves the required fax pages for you and 
places them in your mailbox.

5.2.4  Fax Transmission via Microsoft Outlook

After you have installed the MAPI fax printer driver you can send fax messages 
conveniently from any application. You find details in Chapter 12, “MAPI Fax 
Printer Driver”.
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6  Short Message Service

The SMS protocol must be installed on the OpenScape Xpressions server to 
allow the functions described below. Please consult your system administrator if 
you have any queries.

6.1  Overview

Short Message Service (SMS) enables you to send short messages with a 
standard mail program to GSM network subscribers, thus to mobile phone users 
of supported mobile phone networks.

This service also allows implementing SMS scenarios, for example, gathering 
internet information and sending it as short message.

6.1.1  Application Options

To send SMS messages you can select any e-mail client that provides the facility 
to send e-mails via SMTP. Such clients are, for example, Microsoft Outlook 
Express, or the Netscape Messenger e-mail client, which is integrated in the 
Netscape Communicator. You can also use the SMS via Microsoft Outlook with 
Microsoft Exchange. You can then proceed as described here, or, with installed 
Exchange Connector, follow the descriptions in the Microsoft Outlook Extensions 
manual.

6.1.2  SMS for GSM Boxes

Short Message Service (SMS) for GSM (Global System for Mobile 
Communications) enables you to send short messages to GSM network 
subscribers with a standard mail program. In this transmission mode, one or 
several GSM boxes (also called GSM adapters) are connected to the OpenScape 
Xpressions server. These GSM boxes are special mobile phone devices 
construed for usage in server applications. Special cellphones with the 
corresponding data cable can be used as well. In this connection case the 
OpenScape Xpressions server behaves like a normal mobile phone subscriber.

• SMS for GSM sends via a cell phone device with corresponding board 
connected to the server.

• The SMS transmission can be so configured that merely the message subject 
is sent instead of the message body. Please consult your administrator on 
this.
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• Reply messages from mobile phone subscribers are only supported in 
connection with specially defined variables fields in the SMS text. Please 
consult your administrator on this.

• An SMS message must not exceed 160 characters.

NOTE: Depending on the OpenScape Xpressions server configuration, 
fewer than 160 characters may be available for the actual text message. This 
depends on whether the SMS message is to be sent with additional text infor-
mation. For example, the administrator may define that the originator name, 
a prefix or a suffix is automatically included in the SMS message. Prefixes are 
text information that with a transmission is automatically placed before the 
SMS message text, suffixes are attached to the SMS message text. Please 
consult your administrator on this.

Your system administration may configure the handling of messages that 
exceed 160 characters:

a) The message will not be sent

b) The first 160 characters will be sent only

c) The first line will be sent only

d) All lines until the first blank line will be sent

e) Combination of b) and c)

f) Combination of b) and d)

• Approximately 300 messages can be sent per hour for every connected 
transmitter.

• Umlauts and special characters from Western fonts are allowed in the 
messages. Some special characters may be transferred incorrectly, 
depending on the service center selected. Unicode SMS, which would be 
required for Greek, Cyrillic or other fonts, is not supported.

• Network operators normally store SMS messages for 48 hours, if the cell 
phone user cannot be reached. Within these 48 hours the send process is 
repeated in specific intervals.

NOTE: There is no guarantee that an SMS message will reach the recipient. 
The provider may send a positive receipt signal even if the recipient number 
does not exist.
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6.1.3  SMS via direct Provider Coupling

SMS message transmission via direct provider coupling is the most complete 
type of connection because it exploits all originator and recipient options. In 
addition, this connection type offers high performance, security and favorable 
prices. The OpenScape Xpressions server and provider are connected via the 
TCP/IP protocol. Additional security can be provided by configuring a VPN tunnel 
between the customer and provider.

• SMS via direct provider coupling sends directly to the provider via the TCP/IP 
protocol.

• An SMS message must not exceed 612 characters.

NOTE: Depending on the OpenScape Xpressions server configuration, 
fewer than 612 characters may be available for the actual text message. This 
depends on whether the SMS message is to be sent with additional text infor-
mation. For example, the administrator may define that the originator name, 
a prefix or a suffix is automatically included in the SMS message. Prefixes are 
text information that with a transmission is automatically placed before the 
SMS message text, suffixes are attached to the SMS message text. Please 
consult your administrator on this.

Your system administration may configure the handling of messages that 
exceed 160 respectively 612 characters: One of eight different operating 
modes can be defaulted:

a) The message will not be sent

b) An SMS message with up to 612 characters is divided among up to four 
SMS messages. If the SMS message contains more than 612 characters 
it will not be sent.

c) An SMS message with up to 612 characters is divided among up to four 
SMS messages and sent as one. If the SMS message contains more than 
612 characters it will not be sent. Based on these submessages a modern 
cellphone can display a single message again.

d) One big SMS message with up to 612 characters is sent. This function 
must be supported by the provider. If the SMS message contains more 
than 612 characters it will not be sent.

e) Only the first 160 characters of an SMS message are sent. Further 
characters are omitted (compatibility mode). This mode is activated, for 
example, if both SMS send modes are available.

f) The first 612 characters of an SMS message are divided among up to four 
SMS messages. Further characters will be omitted.
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g) The first 612 characters of an SMS message are divided among up to four 
SMS messages and sent as one. Further characters will be omitted. 
Based on these submessages a modern cellphone can display a single 
message again.

h) This first 612 characters of an SMS message are sent in one big SMS 
message. This function must be supported by the provider. Further 
characters will be omitted.

• Approximately 30000 messages can be sent per hour for every connected 
transmitter.

• Umlauts and special characters from Western fonts are allowed in the 
messages. Some special characters may be transferred incorrectly, 
depending on the service center selected. Unicode SMS, which would be 
required for Greek, Cyrillic or other fonts, is not supported.

• Network operators normally store SMS messages for 48 hours, if the cell 
phone user cannot be reached. Within these 48 hours the send process is 
repeated in specific intervals.

• Your system administrator can default the following delivery notification 
settings:

Settings Remark

None Do not request delivery notifications from the provider for sent 
messages.

Default It is up to the provider which notification types are used for sent 
messages.

Special Here the administrator can define that for the following delivery states 
information will be transmitted:
Delivery Notification: The provider sends reports if the SMS 
message has been successfully transmitted.
Failed Notification: The provider sends reports if the transmission of 
an SMS message has failed.
Buffered Notification: The provider sends reports if SMS messages 
are buffered because e.g. a recipient is currently not available. The 
process will then be repeated within a specific time frame.
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6.1.4  GSM Box Features and direct Provider Coupling

The following table lists the features of both SMS connections, GSM box and 
direct provider coupling (SMS IP). Depending on the installed version, this needs 
to be considered for individual SMS transmission.

Send SMS

SMS message receiving

Feature Comment GSM box SMS IP

Sending

Extra long SMS messages Up to 612 characters.

Special characters Depending on the 
receiving cellphone and 
provider.

Euro sign Depending on the 
receiving cellphone and 
provider.

Performance Depending on the 
provider.

300 SMS 
messages per 
hour

30000 SMS 
messages per 
hour

Extended message 
tracking

The additional send 
reports: sent, saved, not 
saved.

Adaptable originator 
recognition

If supported, then 
depending on the 
provider and contract.

Feature Comment GSM box SMS IP

Editing

Extra long SMS messages Up to 612 characters.

Special characters Depending on the 
sending cellphone and 
provider.

Euro sign Depending on the 
sending cellphone and 
provider.

Addressing via calling 
number

Addressing via token in the 
message text

Receiving via fixed calling 
number
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6.2  Sending short Messages

You can send SMS messages from every client. The connecting type, GSM box 
or direct provider coupling, is insignificant for addressing an SMS message - the 
process is always identical so that the user will not notice any difference when 
sending SMS messages. Merely the performance spectrum is slightly restricted 
when you send SMS messages by GSM box. You find information on the different 
features in Section 6.1.4, “GSM Box Features and direct Provider Coupling”, on 
page 57.

The following section describes how to use the mail software Outlook Express for 
sending SMS messages to cell phone users in the supported mobile phone 
networks. The procedure is identical if you want to use a different e-mail client.

The Internet e-mail software used must support the SMTP standard e-mail 
protocols (for outgoing e-mails) if you want to use it to send SMS messages to 
cell phone users in the supported mobile networks.

Receiving via speed dialing 
code

Receiving as VSMSC

Feature Comment GSM box SMS IP
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How to send an SMS message with Outlook Express:

1. Start Outlook Express

2. Select the command for creating a new message.

a) Via File > New > Mail Message

b) With a click on the Create Mail icon

The New Message dialog opens.

3. Enter the recipient’s address in the To... box.
When addressing, please heed the following rules:

– Begin the address with the SMS/ prefix 

– After the prefix enter the call number of the mobile phone subscriber in 
the complete GSM format. (You can omit the + character).

– Subsequently enter the @ character followed by the domain address of 
your OpenScape Xpressions server.

4. When sending via GSM box:
If your system is configured to transmit the text in the text field only: Enter a 
message header as information text for your own filing in the subject line. 
Entries made in this line will not be transmitted during the sending process. 
Enter the short message in the designated text input area. The message may 
consist of a maximum of 160 characters. Special characters are permitted. 
Avoid rich text formats (fonts, font sizes, font colors, etc.). Formats of this kind 
are lost when the message is sent. If you use an auto signature on e-mails, 
note that the signature is then part of the message text. We recommend to 
delete auto signatures from SMS messages.

If your system is so configured that the subject line is transmitted only: Fill in 
the Subject entry line. Text that may have been entered in the text field will 
not be sent.

NOTE: Remember that with some configurations also the user name, a 
prefix and a suffix might be added, so that for the actual message fewer 
characters are available. Please consult your administrator on this. If the 
entire message comprises more than 160 characters, the originator is 
informed by report that it could not be sent.

5. When sending via direct provider coupling:
If your system uses this type of provider coupling, you can, depending on the 
configuration, send messages with up to 612 characters. You administrator 
will tell you whether this is possible and how to handle the transmission of 
extra long SMS messages. See also Section 6.1.3, “SMS via direct Provider 
Coupling”, on page 55. The message text will be sent only. A message header 
that you may have entered in the subject line will be used as information text 
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for your filing. Special characters are permitted. Avoid rich text formats (fonts, 
font sizes, font colors, etc.). Formats of this kind are lost when the message 
is sent. If you use an auto signature on e-mails, note that the signature is then 
part of the message text. We recommend to delete auto signatures from SMS 
messages.

6. Send the message or place it in the outbox for sending at a later date.

Adding an SMS address to the Outlook Express address book

If you want to send SMS messages to one particular user frequently, it is more 
convenient to add the address to the Outlook Express address book.

How to integrate an SMS message recipient in the address book:

1. Open the Outlook Express address book via Tools > Address Book.

2. Select the command for specifying a new entry (File > New Contact or button 
New > New Contact). The Properties dialog opens.
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3. Select the Name tab as illustrated above.

4. Enter the recipient’s address in the E-Mail Address box.

When addressing, please heed the following rules:

– Begin the address with the SMS/ prefix 

– After the prefix enter the call number of the mobile phone subscriber in 
the complete international GSM format. In the example above, +49 
stands for Germany, 170 is the area code for the network and 12345678 
is the user’s number. 

– Subsequently enter the @ character followed by the domain address of 
your OpenScape Xpressions server.

You can enter further recipient data on additional tabs of the dialog as usual.

You can now click the To... button and select the entry from the address book 
when you wish to create a new message. The names entered in the First Name 
and Last Name boxes in the Outlook Express address book entry are copied to 
the address line.

6.3  Receiving SMS Messages

SMS messages received without special recipient ID in the message text are 
forwarded to the Postmaster.

Direct SMS message transmissions to a specific subscriber can be configured in 
the SMS message text via a coded recipient specification. The administrator 
defines which special characters identify this entry, and which recipient 
information is used for the assignment. The recipient ID can be placed in an 
arbitrary position within the SMS message body The ID within the SMS message 
body corresponds, for instance, to one of the following patterns:

<message text>*<recipient>#<message text>

<message text><<recipient>><message text>

Examples:

*1234#Hello Mr Mayer, ...

<Lisa User>Hello Mr Mayer, ...
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The administrator will tell you which information to fill in for the <recipient> 
variable and which separators to use.

NOTE: If the automatic transmission of the user name with each SMS message 
sent is configured, this text information can also be used for inbound routing. The 
recipient of the SMS message only needs to copy this information, placed 
between the separators, to his/her reply, and delivery occurs automatically.

6.4  Tips for Everyday Use

6.4.1  Sending a Callback Number

You can enter the number under which you can be reached in a separate line in 
the SMS message. Example:

Hello Martin, Stephen here. Please call me at the following 
number: 089722123456

A number is automatically selected when you scroll a message almost any mobile 
phone. This number can be dialed directly when you push the talk key.

6.4.2  Sending SMS Messages from Intranet Pages

If you are working in an intranet environment providing WWW pages for other 
users, you can create hyperlinks in these pages that allow users to send SMS 
messages directly to cell phone users in the supported networks. A sample HTML 
link is provided below:

<a href="mailto:SMS/436647654321@myserver.domain">
SMS to Martin's cell phone</a>

The addressing after mailto: is the same as the direct address entry in an 
Internet e-mail software (see Section 6.2, “Sending short Messages”, on page 
58).

You can also use the addressing in WWW server applications such as CGI 
scripts.
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7  OpenScape Xpressions Voice Mail Systems

7.1   Ergo

Ergo is the name of a voicemail system. Ergo represents, like other voicemail 
systems, access to the OpenScape Xpressions server via telephone. It allows 
users in an Integrated Messaging (IM) or True Unified Messaging (TUM) 
environment to access their mailbox and also to perform a multitude of settings 
by means of telephone keys. Moreover, the system is not bound to a specific type 
of PBX. Thus Ergo is the user interface via which the mailbox content is put out 
and mailbox functions are administered per telephone. Mailbox is the term for the 
data directory in which all incoming messages, be it an e-mail, a fax or voice mail 
are stored for processing at a later date. With reference to the manifold 
configuration options provided by Ergo, the system, as its name already 
suggests, enables Ergonomic operation of all functions as far as possible.

Ergo can be used in different operating modes. These operating modes vary in 
the available functions:

• The standard mode
It offers the basic Ergo features and hides all functions that are used only 
occasionally.

• The enhanced mode
Provides all main menu functions. The user can toggle between standard and 
enhanced mode at will.

• The extended mode
The extended mode must be implemented by the administrator. This 
operating mode provides further detailed settings and is intended for users 
who operate their mailbox exclusively by telephone, thus, who do not have a 
workstation PC for performing settings.

In the standard mode you can...

• ...edit newly incoming messages or those you have already played.

• ...record new voice mails and send them.

• ...be directly connected to another subscriber or to the operator.

• ...perform the fast editing of the day greeting.

• ...modify your mailbox option settings. In the standard mode for example: 
record a welcome greeting, record your name, toggle to the enhanced mode, 
etc.

In the enhanced mode you can use the following features in addition to the 
standard mode functions:
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• Recording up to nine greetings

• Defining three trusted numbers, etc.

• Modifying your message options. Among these are...

– ...the installation of the notification function (informs about the arrival of 
new messages). This includes the definition of a cellphone number as 
address for the notification and specifying the type of message the 
notification is to apply to,

– ...the configuration of additional specific message options. These are: 
switching the sorting order or filtering in the mailbox, and allowing 
messages with attributes such as “urgent” or “confidential”.

The extended mode enables further detailed mailbox option settings:

• Settings for greetings to be played during business hours (daytime mode),

• Settings for greetings to be played out of business hours (nighttime mode),

• Definition of the associated time settings,

• Testing the complete settings.

You find detailed information on the Ergo features and operation in the Ergo 
manual.

7.2  Evo

Evo (Extended Voice Operation) is the name of the new voice-operated voice 
mail system. Similar to other voice mail systems, this system provides access to 
the OpenScape Xpressions server via telephone. Contrary to the existing voice 
mail systems, which are operated via telephone keys, the functions are activated 
by user voice entries in Evo. I.e. all actions a user wants to perform for operating 
and configuring his/her mailbox are realized via spoken commands. The speech 
recognition system allows users in an Integrated Messaging (IM) or True Unified 
Messaging (TUM) environment to access their mailbox and also to perform a 
multitude of configuration settings.

NOTE: The administrator configuration of Evo can provide the user in each 
menu branch with the key operation option in addition to voice control. This may 
be required e.g. if the automatic speech recognition does not guarantee sufficient 
recognition because of external factors (temporary construction noise, 
impairment of the user's audibility etc.).
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7.2.1  Voice Control

Voice-operated usage is possible because of a highly efficient speech recognition 
software. This is characterized by a significantly increased recognition rate. 
Speech recognition works according to the following principle: the voice 
command that has been entered is converted into an electric signal. 
Subsequently this signal is compared to generated signals of different text strings 
that are stored in so-called grammar files. From this, the system calculates a 
percent value (e.g.85 %) that determines as recognition threshold whether the 
match is sufficient to provoke the command or not. If this value is above the 
recognition threshold defined as minimum level, the command is executed. If the 
value is below it, the system prompts you to repeat your entry. For a fluent 
workflow it is absolutely necessary that the user articulates the commands 
clearly.

7.2.2  Mailbox editing by Telephone with Evo

In principle Evo thus is the user interface via which the mailbox content is put out, 
mailbox functions are administered by telephone and telephone connections are 
established. Mailbox is the term for the data directory in which all incoming 
messages, such as e-mail, fax or voicemails are stored for processing at a later 
date. Evo provides the following features:

• Editing newly incoming messages or those you have already played.

• Recording new messages and sending them.

• Being directly connected to another subscriber or to the operator.

• Modifying your mailbox options.
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7.2.3  The Evo Menu Structure

You find detailed information on the Evo features and operation in the Evo 
manual.
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7.3  OpenScape Xpressions PhoneMail

OpenScape Xpressions PhoneMail is a software-based voice mail system that 
can be operated as stand-alone voice mail system, also allowing mailbox access 
in a Unified Messaging environment. In this way it is possible to manage all 
messages delivered to the OpenScape Xpressions mailbox almost exclusively by 
telephone instead of via a client application (Web Assistant, Microsoft Outlook, 
Lotus Notes, Communications etc.).

You can:

• Edit all messages that were delivered to your own mailbox. For example, play 
voice mails, print out fax messages, and have e-mails read out, or answer 
and forward these messages.

• Record voice mails and send them.

• Configure send options for voice mails.

• Set the personal reply options: creating greetings, defining deputies and 
configuring call diversions, etc.

• Be directly connected to other subscribers.

• Edit your personal mailbox settings

7.3.1  Mailbox Editing by Telephone with PhoneMail

With PhoneMail you manage your mailbox via telephone.

PhoneMail enables you to retrieve and administer messages such as voice mails, 
faxes or e-mails. Furthermore, you can record voice mails for other users and 
subsequently send these messages. You can also directly address the mailbox 
of another subscriber to leave a message for this subscriber. You can divert 
callers to your mailbox and enable them to leave voice mails there (answering 
machine function), or play a personal greeting to them (infobox mode). Various 
special functions, such as the direct connection to the originator of an incoming 
message, are also included in the scope of features.

All OpenScape Xpressions users have their own mailbox on the OpenScape 
Xpressions server. With PhoneMail you can access a mailbox via any telephone. 
This means that you can use an internal telephone connected to your 
organization's PBX as well as an external telephone, connected to your 
organization's PBX via a trunk code, to access your mailbox.

You find detailed information on the OpenScape Xpressions PhoneMail features 
and operation in the PhoneMail manual.
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7.4  OpenScape Xpressions VMS

OpenScape Xpressions VMS is a software-based voice mail system that can be 
operated as stand-alone voice mail system, also allowing mailbox access in a 
Unified Messaging environment. In this way it is possible to manage all messages 
delivered to the OpenScape Xpressions mailbox almost exclusively by telephone 
instead of via a client application (Web Assistant, Microsoft Outlook, Lotus Notes, 
Communications etc.). You can:

• Edit all messages that were delivered to your own mailbox. For example, play 
voice mails, print out fax messages, and have e-mails read out, or answer 
and forward these messages.

• Record and send voice mails (also by broadcast).

• Record dictations and send them.

• Set the personal mailbox options (special functions): creating greetings, 
defining deputies and configuring call diversions, etc.

• Modify you answering machine settings by fast access.

• Be directly connected to other subscribers.

7.4.1  Mailbox Editing by Telephone with VMS

With VMS you operate and manage your mailbox via telephone.

VMS enables you to retrieve and administer messages such as voice mails, faxes 
or e-mails. Furthermore, you can record voice mails for other users and 
subsequently send these messages. In addition, you have the option of directly 
addressing the mailbox of another subscriber to leave a message for this 
subscriber. You can divert callers to your mailbox and enable them to leave 
messages there (answering machine function), or play a personal greeting to 
them (infobox mode). Various special functions such as direct connection to the 
originator of an incoming message are also included in the scope of functions. 
VMS also allows you to record and edit dictations and to broadcast messages.

All OpenScape Xpressions users have their own mailbox on the OpenScape 
Xpressions server. This means that you can use an internal telephone connected 
to your organization's PBX as well as an external telephone, connected to your 
organization's PBX via a trunk code, to access your mailbox with VMS.

You find detailed information on the OpenScape Xpressions VMS features and 
operation in the VMS manual.
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7.5  OpenScape Xpressions PhoneMail and OpenScape Xpressions VMS

PhoneMail and VMS can be used in parallel.

7.5.1  Differences in Functionality and Operation 
between PhoneMail and VMS

The table below summarizes the differences in functionality and operation 
between PhoneMail and VMS. It should aid you in deciding which voice mail 
system to use for which purpose. In addition, it highlights the differences in 
operation.

Task VMS PhoneMail

Station authentication for direct 
access/mailbox playback

by means of code number 
(=Hicom PIN) and 
password (PIN)

by means of phone number 
and password (PIN) / 
password (PIN)

Password optional X -

Exit from address entries * (star) # (pound)

Return to main menu from all 
branches

0* -

Send broadcast X -

Create dictation (privilege 
required)

X -

Access to sent 
objects

X -

Job processing job-oriented session-oriented

Help function - X

Quick reference - X

Using general greetings X -

Sequence when 
sending messages

addressing, then recording 
message

recording message, then 
addressing

Variable forward access - X
A31003-S2370-U100-3-7619, 11/2013
OpenScape Xpressions V7 Client Applications, User Guide 69

          



OpenScape Xpressions Voice Mail Systems

Voicemail_Systems.fm

OpenScape Xpressions PhoneMail and OpenScape Xpressions VMS
 A31003-S2370-U100-3-7619, 11/2013
70 OpenScape Xpressions V7 Client Applications, User Guide

         



CyViewer.fm

CyViewer

General Information
8  CyViewer

8.1  General Information

The CyViewer is a client program for viewing fax messages and playing voice 
mails. It can be integrated in any IMAP-based client environments (for example 
Novell Groupwise etc.).

The CyViewer enables the following functions:

1. For fax messages

• Opening files of the formats Fax G3/G4 TIF.

• View adaption (enlarging, turning, browsing in multipage fax messages, 
widening to the current window size and full-page preview).

• Commenting fax messages. This means insertion of images or text. In 
this way a fax can be furnished with remarks before being forwarded or 
replied to, or a fax form can be filled in.

2. For voice mails

• Opening WAV files.

• Playing WAV files (either via sound card or telephone).

• Attaching a voice comment to the WAV file (either via sound card or 
telephone) and saving the result on the computer.

The CyViewer is connected to the XPR server via the XPR Service Provider 
(MSP). The service provider is the global substructure for all XPR client 
applications that use XPR server services. A user profile is required for the 
CyViewer to access the XPR database via the service provider. User profile 
generation can occur automatically via the Windows user account, provided your 
administrator has configured the XPR server accordingly. Otherwise a user profile 
must be defined manually. Consult your administrator on this.

8.2  Who should read this Chapter?

This chapter is intended for CyViewer users as well as for system administrators. 
Here the user finds CyViewer operating instructions, and the administrator will be 
guided along the correct installation of this client program.
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8.3  System Requirements

• Please refer to the Release Notice to learn which Windows operating systems 
have been released for the CyViewer installation.

• The CyViewer requires a Telematic APL with installed PlayWave protocol. 
This protocol is already implemented in the default installation.

The following overview shows the integration of the CyViewer in the system 
environment.

8.4  Installation

You install the CyViewer by locally executing the corresponding setup.exe. 
The setup does not require any user entries except for a possible installation 
directory change. Merely confirm the individual installation steps with Next and 
Finish.

NOTE: The OpenScape Xpressions service provider will be automatically 
installed in the course of the CyViewer installation if the provider has not been 
installed on the client computer yet.

During the installation, the CyViewer registers in the system for the file types TIF 
and WAV. This starts it automatically when you doubleclick such files.

CyViewer

MSP

1 2 3

4 5 6

7 8 9

* 8 #

XPR Kernel

PBX

TCP

Telematic APL

PlayWave
Script
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8.5  Operation

8.5.1  CyViewer Operating Basics

There are different methods of operating the CyViewer. Which of these is the 
most suitable one depends on your personal preferences. Two examples will 
illustrate the useful employment of the CyViewer:

The fast version:

When you receive an e-mail that contains a file attachment in the appropriate 
formats .WAV (voice mail) or .TIF (fax), double-click the attachment. The 
CyViewer starts automatically and opens this message simultaneously. Now you 
can use the view/playback functions provided and edit the message. 
Subsequently you can save it in an arbitrary directory on the computer for 
archiving or forwarding.

The systematic version:

1. Preparation:

Define a directory for exclusively storing incoming fax and voice mail 
messages. Name it for example FAX_VOICE so that you can easily find it.

2. Storing fax messages and voice mails:

When you receive an e-mail that contains a file attachment with the file name 
extension .WAV (voice mail) or .TIF (fax), store the attachment in the 
previously defined directory so that the original attachment is immediately 
archived.

3. View/playback and editing of fax messages and voice mails:

In the Explorer switch to the directory that contains your messages. Double-
click the corresponding message. The CyViewer starts automatically and 
opens the selected file simultaneously. Now you can view/play, edit and 
subsequently store the message for archiving or forwarding under a new 
name.
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8.5.2  Viewing and Editing Fax Messages

When you open a fax message with a double-click, it is displayed in the 
CyViewer’s viewing or editing window.

Via the toolbar you can influence the fax view and insert various graphical 
elements in the fax message.

You can use the following options to customize the fax view:

The following options are available for editing the fax message:

Icon Function

Enlarges the fax display stepwise. Fax enlargement is performed in 
8 % steps referred to the basic value (maximum 11 steps).

Downsizes the fax display stepwise in 8% steps from the basic value 
(maximum 11 steps).

Rotates the representation by 90° counterclockwise.

Rotates the representation by 180°.

Rotates the representation by 90° clockwise.

Displays the first page of a multipage fax document. The icon is only 
active with multipage fax messages.

Skips back to the previous fax page in a multipage fax document. The 
icon is only active with multipage fax messages.

Skips forward to the next fax page in a multipage fax document. The 
icon is only active with multipage fax messages.

Skips to the last fax page in a multipage fax document. The icon is only 
active with multipage fax messages.

Generates an ideal adaption of the fax to the width of the currently 
open window.

The fax is represented as complete page regardless the display 
window size.

Prints the fax document.
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Icon Function

Saves fax document modifications temporarily. Inserted elements are 
integrated in the fax in gray scale representation. In this way you can 
check the appearance of the fax message in which it will arrive at the 
recipient later on.
Note: This function does not allow the permanent saving of the edited 
document; use the Save as feature for this purpose.

Saves a copy of the edited fax document in an arbitrary directory. 
Enabling this icon opens a file selection dialog. To save a fax you can 
use the special fax formats TIF fax document (*.TIF, *.TIFF) and fax 
document (*.fax, *.fg3, *.fg4).

Marks objects already implemented. The mousepointer that first 
appears in the shape of an arrow is replaced with a crossed double 
arrow when it is moved onto a selectable element. A click with the left 
mousebutton selects this object. Alternatively you can select objects 
for editing when you draw a frame around the desired elements with 
the left mousebutton kept pressed.

Generates an arbitrary line in the fax document. Place the paste 
marker at the desired starting point of the line and draw the line with 
the left mousebutton kept pressed. As long as the button is not 
released you can determine the direction, origin and length of the line.

Inserts a rectangle in the document the same way as a line. Through 
moving the editing points with the mouse (the mouse pointer changes 
its appearance depending on the activities performed), the shape of 
the rectangle as well as its position in the document can be adapted 
any way you like.

Inserts a rounded rectangle. You can move the markers to design the 
shape. The corners’ radius can be modified as well. Seize the inner of 
the two markers (at the bottom right corner of the rectangle) and move 
it within the rectangle until the desired shape has been adopted.

Draws an ellipse or a circle in the fax document. The editing options 
are the same as already described for the rectangle.

This function for drawing an arrow is identical with the line function 
except for an arrow head being attached to the line end.

By means of this option you can add text objects to your fax. Enabling 
it opens the “Text and properties” window. In the editing field enter the 
desired text. Formatting the text is then performed via the options 
above this field,
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The following settings are possible:
• Font

By selecting a character set from the types installed in Windows.
• Font Size

Indicates the type size in a range of 8 to 72 point.
• Style

Normal, Medium, Semi Bold and Bold.
• Alignment

Align left, center, right and block.
• Color

Opens a color chart from which you can select the desired color for 
your object. Note that up to now transmitting colored objects per fax 
is scarcely possible. Therefore colored parts are converted into a 
black/white raster before the document is sent. Depending on the 
colors you have chosen, the object may then appear hardly visible 
on the fax document.

• Background
 Opens a color chart from which you can select the desired color for 
your text background.
Note: Please keep in mind the restrictions to colored objects in fax 
documents outlined under Color.

After entering and formatting the text, click OK. Subsequently you can 
place the text within the fax page. For this purpose draw a frame with 
the mouse pointer in the desired place. You can then move or further 
edit the text. You can also insert the same text several times.

This icon provides a stamp function. For using the stamp function see 
Section 8.5.2.1, “Stamp Function”, on page 77.

Places the selected object in the background.

Places the selected object in the foreground.

Moves the selected object to the foreground in z-order. With several 
overlapping objects this process can be repeated until the selected 
object is completely in the foreground.

Moves the selected object to the background in z-order. With several 
overlapping objects this process can be repeated until the selected 
object is entirely in the background.

Icon Function
 A31003-S2370-U100-3-7619, 11/2013
76 OpenScape Xpressions V7 Client Applications, User Guide

         



CyViewer.fm

CyViewer

Operation
8.5.2.1  Stamp Function

Stamping a fax document

1. Enable the selection button .
A list with stamps already defined opens.
Note: The stamps Approved, Received, Rejected and Draft are provided as 
system default with the installation.

2. Select the desired stamp.
The stamp will be appear top left on the currently displayed fax page.

3. Position the stamp text in the desired place of the document.

4. Edit the stamp text via the properties dialog of the context menu if required.
In doing so you can use the same functions as are available for the text 
function (font, font size, style, alignment and color).

Defining a new stamp

1. Enable the stamp icon . The Rubber Stamp dialog opens.
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2. Click the New... button. The dialog for defining the stamp text opens.

3. Enter the stamp text in the editing window and design it via the Font... button.
In addition you can insert a wildcard for Date and Time so that the current 
date and time is displayed with using the stamp.

4. It is possible to add a bitmap file to the rubber stamp via the Browse button 
and a file selection dialog. Thus it is possible to integrate e.g. a company logo 
or a signature signum.

5. Accomplish your settings with OK.

Editing or deleting a stamp

1. Enable the stamp icon . The Rubber Stamp dialog opens.

2. Select the name of the stamp the definition of which you want to edit or delete.

3. Push the Edit... or Delete button.
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a) Clicking the Edit... button opens the stamp definition dialog. Here you can 
modify all settings (font, parameters for date or time) for the selected 
stamp.

b) Click Delete to remove the selected stamp definition from the list.
Note: The stamps Approved, Received, Rejected and Draft provided by 
the system are only temporarily removed from the list. They cannot be 
deleted.
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8.5.3  Playing and Extending Voice Mails

When you open a voice mail via the File > Open menu or by doubleclicking the 
WAV file, the mail will be displayed in the CyViewer editing window.

8.5.3.1  Voice Mail Playback

Using the icons in the editing window’s operating field you can play a voice mail 
either via sound card or telephone. Via sound card or telephone you can also 
record a voice annotation for a voice mail.

You can use the following functions for editing a voice mail:

General 
information

Description

Status displays No matter which medium you use to play the message, the Position 
bar always displays your current position in the tone document in 
relation to the entire length of the recording. The total duration, the 
temporal position as well as the current playback status are displayed 
in the lower portion of the window.

Icon Function

Voice mail playback via telephone. After you have enabled this icon 
you will be called by your telephone for playing the voice mail. 
Depending on your settings, playback occurs via your telephone or the 
local telephone you have specified. 

When you select this function after clicking on the “playback via 
telephone” icon, your telephone is switched to the hand-free speaking 
mode. The voice mail is directly and loudly played via telephone or 
headset. 
Note: If you have switched the output to a local telephone, this feature 
is disabled.

Finishes voice mail output via telephone. This function corresponds to 
putting the phone down.

Voice mail playback via PC sound card. 
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8.5.3.2  Defining an A/B Repeat

To play a specific clip of a voice message you can define an A/B repeat. Proceed 
as follows:

1. Place the position slider at the point from where the clip is to begin.

2. Push the  button.

3. Place the position slide at the point where the clip is to end.

4. Push the  button.

5. Push one of the two playback icons. 
The clip that you have defined is played with the start of the playback function.

Through moving the Position slide with the mouse you can head for 
an estimated position in the voice message. Use the “Position” and 
“Length” status information as assisting indicators for this purpose.

Interrupts voice mail playback. The process is continued when you, 
depending on the output medium, press one of the two playback icons.

Stops voice mail playback and skips back to the beginning of the 
message.

With a click on this icon you can rewind the voice mail by a specific 
time span to reach a particular point in the message. You can set this 
time span in the configuration dialog in gradations of 1, 2, 4 and 8 
seconds.

With a click on this icon you can fast-foward the voice mail by a 
specific time span to reach a particular point in the message. You can 
set this time span in the configuration dialog in gradations of 1, 2, 4 
and 8 seconds.

Defining an A/B repeat How to specify an A/B repeat is described in 
Section 8.5.3.2, “Defining an A/B Repeat”, on page 81.

Clicking this icon opens the Options dialog, in which some voice 
message playback parameters can be changed. See Section 8.5.3.3, 
“The Settings Dialog”, on page 82.

Icon Function
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8.5.3.3  The Settings Dialog

Via  you can open the following settings dialog, in which some voice mail 
playback parameters can be modified.

Option Description

My telephone 
number

If you have a telephone at your workstation and telephony functions 
are installed, the corresponding telephone number is displayed in this 
entry line.

Local 
telephone 
number:

In this entry field you can specify the telephone number of a 
connection used only temporarily. By this option all incoming voice 
messages are routed to the previously defined connection so that you 
can play them there. Activate this setting via the Play Voice Mails on 
option.

Play Voice 
Mails on:

This option allows switching to the telephone intended for voice 
message playback. You can either listen to the mail by means of your 
individual workstation telephone (telephone number) or you can put 
out the message via the device that you have specified under Local 
telephone.
Note: If you have switched the output to a local telephone, picking up 
the receiver cannot be simulated via the  icon.

Voice Message 
Format

Via the voice format combination field you can define the ISDN 
message code for your country. In Europe A-Law, in the U.S. mainly 
µ-Law is used.

If “Browse” is 
pressed

Here you can define the time span for a forward/backward skip in the 
voice message. Four steps are available (1, 2, 4 and 8 seconds).
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8.5.3.4  Recording Functions

You can attach a spoken comment to an opened voicemail and, for example, 
store it on your PC or forward it as file attachment in an e-mail. The following 
functions are available for this purpose:

Icon Function

The icon next to the volume bar indicates that the individual comment 
either overwrites the existing voice mail ( ) or is attached to it ( ).
You toggle between the two operating modes by clicking the 
respectively displayed icon.
Note: Using the overwrite function you can generate individual 
recordings and send them as voice mail (file attachment to an e-mail).

Recording a voice mail or comment via telephone.

Recording a voice mail or comment via PC microphone.

With recordings via microphone you can set the microphone's 
sensitivity. Use the Volume slider to adapt the recording volume to 
your speaking habits.
Note: With recordings via telephone you cannot modify the volume.
A31003-S2370-U100-3-7619, 11/2013
OpenScape Xpressions V7 Client Applications, User Guide 83

          



CyViewer

CyViewer.fm

Operation
8.5.4  The Menu Functions

The CyViewer menu functions are the same for fax and voice mail. In the menu 
bar you find the following menus:

• File menu

• Options menu

• Help menu

Via these menus you can select specific CyViewer functions.

8.5.4.1  The File Menu

Here you can trigger the functions required for basic program operation.

NOTE: Menu functions can also be initiated via hotkeys.

8.5.4.2  The Options Menu

Command Function

Open… This function opens a file selection window, in which you can 
select the file to be opened by the CyViewer.

Save Saves the just opened file under the same name.

Save As... With this option the just opened file can be saved under another 
name.

1 xyzFax1.tif
2 xyVoicemail1.wav
3 xyzFax2.tif
4 xyVoicemail1.wav

This menu portion lists the four fax or voice mail messages 
opened last. A click on the entries reopens the messages (the 
opposite list represents four example entries).

Exit Closes the CyViewer.

Command Function

Open With… This function opens a program selection window in which you can 
select another application for opening the file. You can choose from all 
programs installed on this system that support this format.
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8.5.4.3  The Help Menu

Command Function

About 
CyViewer

Displays the CyViewer version installed on your system. For example: 
CyViewer 7.11 (Release build xxxx). This information is required, for 
example, in problem reports.
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9  Conversation Recorder

The installation of the Conversation Recorder telematic protocol enables users to 
record telephone conversation. From the technical point of view, a conference 
switch is initiated via the Conversation Recorder, and the Converstion Recorder 
is switched to an existing call connection as another terminal device. When you 
activate the recording, the participating conversational partners are informed by 
a greeting that the conversation is being recorded. After the conversation the 
recording is automatically transmitted as voice mail to the mailbox of the user who 
has initiated it.

IMPORTANT: We expressly point out that conversation recording by means of a 
recording function requires the explicit consent of all persons taking part in the 
conversation. Otherwise, this may constitute a violation of the data protection act 
of the country in which this function is used. Therefore, before you use the 
recording function, obtain legal advice about the corresponding rules and regula-
tions valid in the country in which the recording function is to be used.
We recommend to document the consent of the conversational partners given on 
the use of the recording function.

9.1  Operation

How to operate the Conversation Recorder:

1. You are conducting a conversation that you want to record.

2. Initiate a consultation.

3. Dial the phone number assigned to the Conversation Recorder.

All participants in the conversation now hear a message that informs them 
that the conversation will be recorded and recording is started.

4. Recording is stopped when

a) the conversation or the teleconference is finished.

b) one of the subscribers taking part in the conversation or in the 
teleconference presses an arbitrary DTMF key on his/her telephone.

c) the maximum recording duration set by the administrator has been 
reached.

The recording is then automatically delivered as voice mail to the user who 
called the Conversation Recorder by consultation.
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10  Caller Guide

10.1  What is the Caller Guide?

The Caller Guide is a switching assistant preferably operated by voice. With the 
Caller Guide you can search for contacts in the OpenScape Xpressions database 
and immediately set up a connection to the OpenScape Xpressions user found.

A few standardized commands and an efficient speech recognition system allow 
to operate the Caller Guide easily via voice entries. But you can also easily use 
telephone keys for search entries and to control the Caller Guide. The usage is 
simplified because of the search hit list that is issued by prompts or the telephone 
display.

There are five options for the connection setup targets:

• Call tracking for individually configured tracking phone numbers of the 
OpenScape Xpressions user.

• Connecting to the voice mailbox of the OpenScape Xpressions user you want 
to find.

• Connecting to the workstation's phone number of the OpenScape Xpressions 
user you want to find.

• Forwarding the call to an operator.

• Finally: identification of fax messages and forwarding to the selected contact.

NOTE: This chapter contains exclusively the operator guidance of the Caller 
Guide. Administrators who wish to install, set and configure the Caller Guide 
protocol should consult the corresponding section of the Telematic APL chapter 
in the Server Administration manual.

10.2  Voice-activated Dialing and Telephone Keys

Operator guidance by means of the Caller Guide is principally possible in two 
ways:

• Via speech entries.

• Via your telephone keys. 

The Caller Guide has been designed to allow usage of both versions in one 
search process.
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10.2.1  Voice Entries

Voice-operated usage is possible because of a highly efficient speech recognition 
software. Speech recognition works according to the following principle: the voice 
command that has been entered is converted into an electric signal. Afterwards, 
this signal is compared to previously generated signals of different text strings 
that are stored in so-called grammar files. From this, the system calculates a 
value in percent (e.g. 85 %) that defines whether the match is sufficient for 
triggering the command or not in comparison with the configured recognition 
threshold. If this value is above the recognition threshold that has been defined 
as the minimum threshold, the command will be executed as recognized. If the 
value is below the threshold, the system asks you to confirm the result that has 
been recognized. In order to work smoothly it is absolutely necessary for you to 
say your commands very clearly.

The menu prompts simplify triggering the commands, as the name that is 
searched for or the respective commands are played for each step of the contact 
search. Keywords (voice commands) to trigger an action ensure that the Caller 
Guide can correctly recognize and execute the desired function. Furthermore, 
entering names and commands via voice makes working with the Caller Guide 
much faster.

For instance, you can control with your voice the security prompt asking whether 
a connection shall be established to a search hit. Here you are prompted to 
complete your action with “Yes”. By saying “No”, no connection is established and 
you will automatically return to the menu branch where you started your search.

As mentioned above, working efficiently with the Caller Guide is only possible if 
you say your commands clearly. Therefore you should avoid using the Caller 
Guide in environments with noisy disturbances. These might lead to 
misinterpretations by the recognition software. The same applies for the “hands-
free” telephone mode for which the output via loudspeaker is again recognized as 
input.

10.2.2  Input via Telephone Keys

In addition to speech recognition, the Caller Guide script offers the option to use 
telephone keys for menu navigation. This can be required e.g. if the automatic 
speech recognition does not guarantee sufficient recognition quality for speech 
entries because of external factors (noise, impairment of the user's audibility etc).

Pushing a key starts the name dialing mode. It is also possible to say “Name” 
before the search and change explicitly to the name dialing mode for the contact 
search.

For a search via telephone keys each letter of a name or term that you wish to 
find is entered via one telephone key. For the letters“A”, B” and “C” push key “2”, 
for the letters “D”, “E” and “F” push “3” etc.
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Each entry refines the search process. Thus a unique search hit can be early 
detected and a hit list will be displayed for selection. Consequently, it is not 
necessary to enter the search term completely. This shortens the search times.

10.3  Tracking Phone Numbers and Personal Announcements

Tracking phone numbers are phone numbers the Caller Guide dials for setting up 
a connection to an OpenScape Xpressions user. A total of five phone numbers or 
deputies can be defined in a list. The individual list entries are dialed one after 
another until a connection can be established or until the complete list has been 
processed.

IMPORTANT: If the administrator set the Blind Transfer feature during the 
Caller Guide configuration, only the first list entry of the tracking phone numbers 
is dialed. The remaining list entries can be filled in the Web Assistant, but are not 
considered by the system after the activation of Blind Transfer.
Blind Transfer describes the forwarding of calls though the availability of the 
receiving target has not been checked. 

The tracking phone number configuration and the recording of personal greetings 
is effected via the Web Assistant. You configure the phone numbers via the menu 
option Voice Mail System of the Personal settings menu.

NOTE: If calls are redirected from the office telephone to the Caller Guide, the 
defined tracking phone numbers stay active.

Instead of using the name announcements created automatically by the TTS 
system for the individual OpenScape Xpressions users, each OpenScape 
Xpressions user can create their own announcement. The names of the 
OpenScape Xpressions users are played as result after each search.

The announcements are recorded via the menu option Announcements in the 
Personal settings menu and add these to the user data.

NOTE: For a detailed description of the personal user parameters of the Caller 
Guide please refer to the Web Assistant.
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10.4  Operation

10.4.1  Basics for the Caller Guide Operation

After you have established a connection to the Caller Guide, announcements will 
guide you through the single connection steps. Thus you will have feedback on 
each operating step you have effected for a better control of your actions.

The following illustration demonstrates the possible steps and processes of the 
Caller Guide. The numbering in the illustration corresponds to the numbering of 
the enumeration of the single steps.

1. A redirection of the office telephone to the Caller Guide will be recognized and 
the owner of the originally called telephone is immediately accepted as 
uniquely identified.

2. Search a contact you would like to find by using either voice-activated dialing 
or telephone keys. The OpenScape Xpressions database is searched with 
your search entry and returns the search hits.

3. If a unique hit is found or if you select an entry from the hit list, a connection 
to the first configured number of the contact will be established. If it is not 
possible to set up a connection to this configured number, the next configured 
number will be dialed until a connection can be set up successfully or finally 
a connection to the voice mailbox of the contact is established.
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4. Two different cases can be distinguished:

a) If the called telephone is redirected to the Caller Guide, the Caller Guide 
recognizes this redirection and the owner of this telephone is immediately 
accepted as identified. If he/she has configured a number, the system 
tries to contact him/her immediately via this number. Otherwise you will 
be connected to his/her voice mailbox.

b) If no configured numbers of the identified contact exist and if the office 
phone is not redirected to the Caller Guide, you will be connected to the 
office phone.

5. If no OpenScape Xpressions user is found or if the number of search hits is 
too large, you have to restart your search or select an entry from a list in case 
several search hits were issued. After three unsuccessful search attempts 
you will be connected to the operator.

The next paragraphs contain a detailed description of the single steps you will 
need to perform.

10.4.2  Basic Features

10.4.2.1  Repeating System Announcements

If you do not trigger any of the features that have been announced in a menu, that 
is if you neither make a voice entry nor push a key, the announcement will be 
repeated in a more detailed way. To hear a prompt again, simply wait until it is 
repeated. This is useful, for example, if you did not hear the announcement 
properly.

If no entry has been made after three repetitions of the announcement, you will 
be automatically connected to an automatic operator. 

10.4.2.2  Requesting Help

If you do not know how to continue in a menu, you can say the voice command 
“Help” and an announcement will explain the menu options. The help prompts 
always refer to the menu branch you are currently in. These extended help 
prompts will then inform you about the selections you can currently make in the 
menu.

10.4.2.3  Ending a Connection

You can terminate the connection to the Caller Guide any time by simply hanging 
up the receiver of your telephone.
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10.4.3  Finding and selecting a Contact

10.4.3.1  Search via voice-activated Dialing

The following illustration demonstrates the possible steps and processes of the 
Caller Guide. The numbering in the illustration corresponds to the numbering of 
the enumeration of the single steps.

NOTE: Please make sure to say the names and commands clearly when you 
use voice-activated dialing. If a contact cannot be found, the reason could not 
only be that he/she is not in the directory, but it could also be that your pronunci-
ation for the search has not been exact enough.

1. At first the Caller Guide starts with a welcome greeting when you call. You are 
asked to enter the contact you would like to find via voice-activated dialing. 
Say the name of the contact you are looking for clearly. The required order of 
first name and last name is explained in the announcement, since this order 
may vary due to the administrator settings. In both cases you can also only 
say the last name, but the recognition probability will then decrease.
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2. The search hit(s) will now be shown in your telephone display or a prompt will 
be played informing you that no contact could be found. 

a) Unique match: A unique search hit is announced and shown in the 
telephone display. If the recognition value is above the threshold that has 
been configured, you will be connected automatically. If it is below the 
threshold, you first have to confirm the result that has been recognized. If 
you would like to be connected to the match that is displayed, say the 
command “Yes” or push the * key. You will return to the greeting and to 
the search by saying the command “No” or by pushing the # key.

b) Several matches: If several matches have been found for your search 
entry, you have to select one contact. Select the respective key for a list 
entry. The order in the list corresponds to the keys of the numbers 1 up to 
a maximum of 5.
If more than five matches have been found, the following options are 
announced:

– You can be connected to the operator

– You can repeat your entry in a more detailed way.

c) No match: If no match could be found for your search, return to the 
search and thus to 1.).

d) Operator: It is possible to search for a contact three times. After the third 
failed search you will be connected to the operator.

3. You will receive an announcement confirming that you are connected to the 
selected contact.
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10.4.3.2  Search via the Telephone Keys

The following illustration demonstrates the possible steps and processes of the 
Caller Guide. The numbering in the illustration corresponds to the numbering of 
the enumeration of the single steps.

1. At first the Caller Guide starts with a welcome greeting when you call.

2. If you would like to look for the desired contact via the telephone keys, either 
say clearly “Name” or simply push the first key of the contact's name. The 
name dialing mode to search for a contact via the telephone keys will then be 
started.

3. Enter the name of the contact you would like to find via the telephone keys. 
Three or four letters are assigned to each telephone key. Push the respective 
telephone key for every single letter of the name you are looking for. However, 
push each key only once for each letter. For instance, push the key “1” for the 
letters “A”, “B” or “C” once and not twice for B or three times for C. The 
umlauts “ä”, “ü” and “ö” as well as “ß” become “ae”, “ue”, “oe” and “ss”. For 
the name “Müller” e.g. push the key sequence “6835537”. 
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4. After each input of a digit an automatic search is started after a short time of 
delay. For instance, after the input “2” all entries starting with “A”, “B” and “C” 
are searched for and may be issued (if the maximum number of entries in the 
hit list is not exceeded). If the contact that has been searched for is already 
displayed in this hit list, you can stop entering additional digits and instead 
start to establish a connection to the selected search hit.

NOTE: You do not need to enter the complete name of the contact you are 
looking for. Entering only a few letters already enables the search for a 
contact. The administrator determines the minimum number of letters that 
must be entered for the search. By default, the search requires two letters. 
However, the number of letters that have been entered increases the proba-
bility of a unique search hit, so that you do not have to render the search 
process more precisely or to select the contact you are looking for from a list 
of contacts that have been found.

If you do not want to wait for the time of delay, confirm your entry by pushing 
the # key and the search will be started. Pushing the * key cancels the 
process and you will return to the greeting prompt.

5. The search hit(s) will now be shown in your telephone display or a prompt will 
be played informing you that no contact could be found. 

a) Unique match: A unique search hit is announced and shown in the 
telephone display. You are connected immediately.

b) Several matches: If several matches have been found for your search 
entry, you have to select one contact. Move up or down the list via the # 
key and select the corresponding keys to a list entry. The order in the list 
corresponds to the keys of the numbers 1 up to 5 maximum. You return 
to the greeting and thus to the search via the * key.
If more than five matches have been found, the following options are 
announced:

– You can be connected to the operator

– You can repeat your entry in a more detailed way.

c) No match: If no match could be found for your search, return to the 
search and thus to 1.). 

d) Operator: You have three attempts to find a contact. After the third failed 
search you will be connected to the operator.

6. You will receive an announcement confirming that you are connected to the 
selected contact.
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10.4.4  Be connected

NOTE: You cannot influence the actions that will be explained in the next 
paragraph. This paragraph is only meant to depict the principles of the connection 
setup.

If the selected contact's name could not be found unambiguously, two possibilities 
for the connection setup exist. These possibilities do not depend on the entries 
the caller made, but on the settings of the contact. These settings refer to the 
numbers configured in the Web Assistant. Consequently, the connection target 
depends on whether the respective contact has configured at least one phone 
number for further routing or if a redirection has been activated.

The following illustration demonstrates the possible steps and processes of the 
Caller Guide. The numbering in the illustration corresponds to the numbering of 
the enumeration of the single steps.
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1. If no number has been configured for the selected contact, the following might 
be the case:

a) The contact has been identified, since he/she has redirected his/her 
telephone to the Caller Guide. You will be connected to the voice mailbox 
of the selected contact. 

b) The contact has been recognized due to the caller's entries, however, he/
she has not configured any numbers. You will be connected to the office 
phone, which is entered in the database for each OpenScape Xpressions 
user.

2. If at least one tracking phone number has been configured, the following 
steps will be performed by the Caller Guide:

a) The first number in the list of tracking phone numbers that have been 
connected is dialed. 

b) If no connection to the contact can be established, the system checks 
whether further phone numbers are available for a possible connection.

c) If additional numbers exist, they are dialed one after another. 

d) If no additional numbers exist or if no connection can be established to 
the additional numbers, you will be connected to the voice mailbox of the 
contact.

10.5  Commands

The following commands are available for voice-activated dialing.

Command Description

“Yes” This command confirms the connection setup to a contact that has 
been found. For this feature you can, depending on the 
configuration, either use the # or the * key.

“No” This command discards the connection setup to a contact that has 
been found. You will return either to the search or to the hit list. For 
this feature you can, depending on the configuration, either use the 
# or the * key.

“Help” Executing this command repeats the greeting prompt that contains a 
short explanation how to perform a search.

“Name” This command starts the name dialing mode so that you are able to 
make search entries via the telephone keys.

<Name> To search via voice-activated dialing you need to say the <name> of 
the person you would like to call clearly. The required order of first 
name and last name is explained in the announcement, since this 
order may vary due to the administrator settings. In both cases you 
can also only say the last name, but the recognition probability will 
then decrease.
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10.6  Quick Reference Guide

The following quick reference guide provides you with the most important Caller 
Guide operating instructions.

10.6.1  Searching for a Contact via Telephone Keys

If you would like to look for the desired contact via your telephone keys, use the 
voice command “Name” or simply dial the name via your telephone. The name 
dialing mode to search for a contact via telephone keys will then be started.

Enter the last name and the first name of the contact you would like to find via 
telephone keys. Letters are assigned to each telephone key in alphabetical order. 
Push the respective telephone key for every single letter of the name you are 
looking for. However, push each key only once for each letter. For the name 
“Müller” e.g. push the key sequence “6835537”. 

NOTE: You do not need to enter the complete name of the contact you are 
looking for. Entering only one letter already enables the search for a contact. After 
a short time of delay (depending on the administrator settings) an automatic 
search starts that already issues search hits, if the maximum number of allowed 
search hits is not exceeded. After this automatic search you can either select a 
match from the list, make the search more precise by entering additional digits or 
cancel and restart the search.

Confirm your entry by pushing the # key and the search will start automatically. 
Pushing the * key cancels the process and you will return to the search via name 
dialing mode (search via telephone keys).

Matching database entries are searched for your entry and the name of the 
search hit will be shown in the telephone display for confirmation as well as 
announced. If you receive a list with several matches, you need to select one 
search hit (Section 10.6.5, “Selecting Hits from the List in Name Dialing Mode”).

You may repeat the search three times. After these three search processes a 
connection to the operator will be established automatically.
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10.6.2  Contact Search via Voice-activated Dialing

NOTE: Please make sure to say the names and commands clearly when you 
use voice-activated dialing. If a contact cannot be found, the reason could not 
only be that he/she is not in the directory, but it could also be that your pronunci-
ation for the search has not been exact enough.

If you would like to look for the desired contact via voice-activated dialing, say 
clearly the last name of the contact you would like to find. 

Your input is searched for and the name of the search hit will be shown in the 
telephone display as well as announced.

If the search by saying the last name is not unique, i.e. several entries with the 
same last name exist in the OpenScape Xpressions database, you need to 
render your search entry more precisely. Therefore say the first name of the 
selected contact or the number from the list that is played. If it is again not 
possible to find a unique contact, repeat saying the first name.

You may repeat the search three times. After these three search processes a 
connection to the operator will be established automatically.

10.6.3  Becoming connected via Telephone Keys

If a unique search hit is found in the name dialing mode, you will be connected 
immediately. For verification, the name of the contact will be announced and the 
name and the phone number will be shown in the telephone display.

If no unique search hit can be found via the name dialing mode but a list, you can 
find a respective explanation in Section 10.6.5, “Selecting Hits from the List in 
Name Dialing Mode”.
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10.6.4  Becoming connected via Voice-activated 
Dialing

If you search for a contact via voice-activated dialing, the name and the phone 
number of the search hit will be shown in the telephone display and the name will 
be announced. If the recognition rate is above the threshold value that has been 
configured, you will be connected immediately. Otherwise, the result that has 
been recognized has to be confirmed first. A connection to this contact can be 
established with the voice command “Yes” or by pushing the # key. The command 
“No” or pushing the * key returns you to the search. If the result is not confirmed 
for three times or if three search runs had no success, you will be connected to 
the operator.

If no unique search hit can be found via voice-activated dialing but a list, you can 
find a respective explanation in Section 10.6.6, “Selecting Hits from the List in 
Voice-activated Dialing Mode”.

10.6.5  Selecting Hits from the List in Name Dialing 
Mode

If your entry was not unique, a list of your hits appears in the telephone display, 
provided that fewer than six hits were found. The list is thus limited to five entries 
to be displayed. Each entry is assigned to the telephone keys 1 to 5. The 
individual list entries are automatically processed. During this process the name 
and the phone number of the entry are displayed and the name is announced. By 
pushing the # key you jump to the next entry. Pushing the * key discards the hit 
list and you will return to the search.

10.6.6  Selecting Hits from the List in Voice-activated 
Dialing Mode

If your entry was not unique, a list of your hits appears in the telephone display, 
provided that fewer than six hits were found. The list is thus limited to five entries 
to be displayed. Each entry is assigned to the telephone keys 1 to 5. The 
individual list entries are automatically processed. During this process the name 
and the phone number of the entry are displayed and the name is announced. A 
connection to the selected contact can be established with the voice command 
“Yes” or by pushing the # key. Pushing the * key or saying the voice command 
“No” discards the hit list and you will return to the search.
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10.6.7  Repetition of the Connection

If it is not possible to establish a connection with the first phone number, the next 
configured phone number in the OpenScape Xpressions system is searched for 
in an iterated process. This process is continued until a connection can be 
established to one of the contact's phone numbers indicated in the OpenScape 
Xpressions system, or until no further number is indicated. In this case you will be 
connected to the voice mailbox of the contact.

10.6.8  Connecting with Redirection Number

If the selected contact has not configured any phone numbers in the OpenScape 
Xpressions system, a connection to the voice mailbox of the selected contact will 
be established.

10.6.9  Fax Routing

The Caller Guide can recognize incoming fax messages and forward them to a 
selected contact. If a contact has been selected unambiguously, the fax will be 
forwarded to this contact. If a fax is sent to a device that is redirected to the Caller 
Guide, the contact is identified via the originally dialed number and the fax will be 
sent to the mailbox of this contact.
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11  Client Integrations

The Client Integrations application allows using the Click-to-Dial function 
independently from the installation of a CTI client. You can thus implement and 
use this function in a large number of clients.

11.1  Client Integrations Features

The Client Integrations application lets you initiate phone calls via any journal 
entries from within specific clients (Click-to-Dial) installed for this function.

The following function are provided via the Client Integrations:

• Callback to originators of any messages.

• Direct call, for example via any contact, calendar and task entry that contains 
contact information.

• After initiating a call, the OpenScape Web Client call control opens 
automatically if the OpenScape Web Client URL is entered in the Client 
Integrations setup and the Use Click-to-Communicate option is set.

• Direct calling via marked phone numbers on internet pages for the browsers 
Microsoft Internet Explorer and Mozilla Firefox.

11.2  Supported Clients

You can install the Client Integrations features using the Client Integrations setup 
for the following clients:

• Microsoft Outlook

• Lotus Notes

NOTE: In Lotus Notes you can use the Click-to-Dial feature for contact 
entries only.

• Sametime Connect

• Microsoft Internet Explorer 

• Mozilla Firefox

You find the latest information about the supported clients and their versions in 
the OpenScape Xpressions Release Notice manual.
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11.3  Using Client Integrations

11.3.1  Usage Requirements

• The Client Integrations must be installed for the client from which you wish to 
use the functions.

• The journal and contact entries you wish to use for a return call must be 
available with a phone number.

11.3.2  Operation

How to call any journal entry from your mail client via the Client Integrations: 

1. Select the entry you wish to call in your mailbox, calendar or address book.

2. Click on Dial.

3. Enter your user data for authentication if you have not done this yet.

NOTE: Authentication is only required when you use the call function for the 
first time or after changing the password. Thereafter, the call is initiated 
without previous authentication.

The call is initiated via the web client. 

NOTE: If you have selected the Click-to-Communicate option during the instal-
lation, the call control opens directly for visualizing and controlling the calls.
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12  MAPI Fax Printer Driver

After you have installed the MAPI fax printer driver you can send documents as 
fax message from any applications via the Microsoft MAPI interface or via the fax 
form of the Microsoft Outlook Extensions. To this, a printer driver named Tiff Fax 
G3 TurboBits Printer is installed on the system. This driver is directly connected 
to the MAPI interface. The document is sent to the printer driver via the Print 
function of your application, and transmitted as fax message from there.

IMPORTANT: The MAPI fax printer driver is not supported for terminal server 
environments.

How to send a document as fax from any application:

1. When your document is ready for sending, select Print in the relevant 
application. The selection menu for the printer driver with which the document 
is to be sent opens.

2. Select the printer Tiff Fax G3 TurboBits Printer.

3. Click on the Print button.

Depending on the setting Microsoft MAPI (printer driver default) or 
Microsoft Outlook (if the OpenScape Xpressions Microsoft Outlook 
Extensions are installed), the appropriate form for sending the fax message 
opens automatically.

4. Enter the recipient address in the To field and, if required, copy recipients 
under Cc. 

When sending via Microsoft MAPI the name of the fax file is automatically 
set in the subject line of the fax message. You can replace this default with an 
individual subject entry or supplement it.

When sending via Microsoft Outlook you can compose an individual subject 
entry.

5. Click Send to transmit the fax message.
A31003-S2370-U100-3-7619, 11/2013
OpenScape Xpressions V7 Client Applications, User Guide 107

         



MAPI Fax Printer Driver

MAPI_Fax_Druckertreiber.fm
 A31003-S2370-U100-3-7619, 11/2013
108 OpenScape Xpressions V7 Client Applications, User Guide

         



MSP.fm

Service Provider (MSP)
13   Service Provider (MSP)

The Service Provider serves as global substructure for all client applications that 
want to use OpenScape Xpressions server services. Such clients are for 
example: Lotus Notes Extensions, Microsoft Outlook Extensions or the client 
Communications etc. While several client applications can simultaneously be 
operated on one computer, only one Service Provider entity is available.

The following services are provided:

• Local database (cache)

Every client application does not have to keep its own database up to date. If 
required, the Service Provider synchronizes its local database with the 
database of the OpenScape Xpressions server. Thereby, the contents of the 
local database is made available to all client applications so that fast access 
is always possible.

• Store & forward interface

Client applications can send documents to or receive them from a 
OpenScape Xpressions server. This refers to classic communication by fax, 
e-mail etc. The optiClient 130 CTI journal operates via this interface as well.

• Transactions interface

Client applications can communicate with the OpenScape Xpressions server 
components that support transactions. This enables in particular the CTI 
functionality for client applications as in optiClient 130.

According to requirements the MSP is automatically implemented upon the 
installation of a OpenScape Xpressions client component. When the installation 
is completed you will find the file MSP.INSTALL.LOG in the TEMP directory of 
the installing user, helping to detect errors if problems should occur.

The Service Provider is started by the first client application requiring it. The 
Service Provider configuration module in the control panel is such an application.

For further information on the service provider and on profile definition refer to the 
Server Administration manual.
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13.1  Connection of the OpenScape Xpressions Server to the Clients via the 
MSP

The MSP-based Windows client applications can also communicate with the 
OpenScape Xpressions server via an IP protocol.

On the server side the TCP/IP APL uses port 8944 for accessing the client. With 
active delivery from the TCP/IP APL to MSP-based client applications port 8968 
is used. This type of communication is not encrypted. By means of a network 
sniffer you can play all data transmitted between server and client.

You can also communicate via a connection secured by SSL. On the server side, 
all corresponding requirements have already been met as a certificate has been 
configured for the STunnel program.

For a connection secured by SSL, port 8945 is used. If you then lock port 8944 in 
the Windows firewall, clients without activated encryption will not be accepted any 
more.

If a firewall is active on the client, the data transmission between OpenScape 
Xpressions server and client must be released by the firewall. In other words, if 
the firewall is active, the MSP on the local clients with the operating systems 
Windows XP and Windows Vista must be given outgoing access to the 
OpenScape Xpressions server. For this purpose the MSPSVC.EXE and 
STUNNEL.EXE programs are added to the exception list of the firewall. On an 
English Windows the programs are installed in the following directory:
C:\Program Files\Common Files\Cycos\Service Provider\. 

Depending on the operating system language the path may vary. In this case look 
for one of the above programs and determine the setup directory.

MSPSVC.EXE is the Service Provider. It is installed as service. STUNNEL.EXE is 
used for encrypted communication with the XPR server.

Client

Server Server to Client: Port 8968
Client to Server: Port 8944

Unencrypted MSP
TCP/IP 

APL

Client

Server

Stunnel
on Server

Stunnel
on ClientPort 8945

Encrypted

TCP/IP 
APL

Loopback
via Port 8944 Loopback

MSP
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The following steps are required:

For Windows XP

1. Open the control panel via Start > Control Panel.

2. Start the application Windows Firewall.
The Windows Firewall dialog opens.

3. Switch to the Exceptions tab.

4. Click on the Add Program... button.
The Add a Program dialog opens.

5. Click on Browse....
The Browse dialog opens.

6. Enter the path for the directory that contains the files MspSvc.exe and 
stunnel.exe.

7. Select the file MspSvc.exe and click on Open.
The selected file is added to the programs of the exception list.

8. In the Add a Program dialog click on the OK button to complete the selection 
process for this file.
You return to the Windows Firewall dialog.

9. Click on the Add Program... button again.
The Add a Program dialog opens.

10. Click on Browse... again.
The Browse dialog opens.

11. Enter the path for the directory that contains the files MspSvc.exe and 
stunnel.exe.

12. Select the file stunnel.exe and click on Open.
The file stunnel.exe is added to the programs of the exception list.

13. In the Add a Program dialog click on the OK button to complete the selection 
process.
You return to the Windows Firewall dialog. The selected programs are now 
integrated in the list under Programs and Services.

14. In the Windows Firewall dialog click on OK.

15. Close the control panel.

In Windows XP the firewall for these programs is now open.

For Windows Vista

1. Open the control panel via Start > Control Panel.

2. Start the application program Windows Firewall.
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3. There, enable the link Allow a program through Windows Firewall.
The Windows Firewall dialog opens.

4. Switch to the Exceptions tab.

5. Click on the Add Program... button.
The Add a Program dialog opens.

6. Click on Browse....
The Browse dialog opens.

7. Enter the path for the directory that contains the files MspSvc.exe and 
stunnel.exe.

8. Select the file MspSvc.exe and click on Open.
The selected file is added to the programs of the exception list.

9. In the Add a Program dialog click on the OK button to complete the selection 
process for this file.
You return to the Windows Firewall dialog. 

10. Click on the Add Program... button again.
The Add a Program dialog opens anew.

11. Click on Browse... again.
The Browse dialog opens.

12. Enter the path for the directory that contains the files MspSvc.exe and 
stunnel.exe.

13. Select the file stunnel.exe and click on Open.
The file stunnel.exe is added to the programs of the exception list.

14. In the Add a Program dialog click on the OK button to complete the selection 
process.
You return to the Windows Firewall dialog. The selected programs are now 
integrated in the list under Programs and Services.
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15. In the Windows Firewall dialog click on OK.

16. Close the control panel.

In Windows Vista the firewall for these programs is now open.

13.2  Setup Adjustments

You can edit the .msi file of the client application involved in the MSP installation 
to perform a “silent”, thus without user interaction, MSP setup. This requires 
editing the msi file with a Windows Installer Package Editor (for example “Orca”) 
to allocate the MSP parameters.

You find the editable parameters in the “Property” table of the msi file.

You can transmit the following parameters for a “silent” MSP setup via the msi file 
of the corresponding client application:

Creating a profile for the MSP automatically

Creating the MSP profile automatically must be activated.

Profile name

Transmission of a profile name for the profile with which the user logs on to the 
client application. The profile name is a descriptive entry that will later be 
displayed for selecting different user profiles.

User ID

Transmission of the user ID for the profile with which the user logs on to the client 
application. If the XPR server supports Windows authentication, you can 
configure the login via Windows user account by transmitting a 0.

Server name

Transmission of the XPR server name for the profile with which the user logs on 
to the client application.

Property MSP_CREATEDEFAULTPROFILE.DCD7C495_D8E8_4B53_ACEC_7C097A0C1B81

Value 0 (disabled) or 1 (enabled)

Default Value 0

Property MSP_DEFAULTPROFILE.DCD7C495_D8E8_4B53_ACEC_7C097A0C1B81

Value <profile name>

Default Value default

Property MSP_DEFAULTUSER.DCD7C495_D8E8_4B53_ACEC_7C097A0C1B81

Value <user ID> or 0

Default Value ADMINISTRATOR
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Server name

Transmission of the XPR server IP address for the profile with which the user logs 
on to the client application.

Property MSP_DEFAULTSERVERNAME.DCD7C495_D8E8_4B53_ACEC_7C097A0C1B81

Value <server name of the XPR server>

Default Value MYSERVER

Property MSP_DEFAULTSERVERIP.DCD7C495_D8E8_4B53_ACEC_7C097A0C1B81

Value <IP address of the XPR server>

Default Value  127.0.0.1
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14  MSP TAPI Service Provider (MSPTSP)

NOTE: The MSPTSP cannot be operated on 64-bit operating systems.

The MSPTSP (MSP TAPI Service Provider) enables calling from within, for 
example, Microsoft Outlook, with dialing out being the only option when Microsoft 
Outlook is used. For certain other applications there are also the following options 
(the TAPI features appear in brackets):

• Answer a call (Answer)

• Transfer without consultation (BlindTransfer1)

• Call replacement, e.g. callback if busy (CompleteCall)

• Three-party conference after consultation (CompleteTransfer)

• Forward after consultation (CompleteTransfer)

• Drop an incoming call (Drop)

• Hang up (Drop)

• Forward (Forward)

• Please do not disturb (Forward)

• Hold (Hold)

• Call (MakeCall)

• Pick up (Pickup)

• Redirect (Redirect)

• Three-party conference (SetupConference)

• Consultation (SetupTransfer2)

• Alternate (SwapHold)

• Unhold

The MSPTSP enables you to use several lines at a time, i. e. an application can 
be opened several times and in different ways. The MSPTSP enables access to 
XPR CTI functionalities also for foreign TAPI based applications via third party 
TAPI clients. The MSPTSP is a TAPI service provider transforming the TAPI 

1. Blind Transfer: an incoming call will be transmitted to another extension even if the line is busy 
or the corresponding subscriber cannot be reached. In this case, the caller has to call again be-
cause he/she will not be automatically put through to the other party once the line is free again.

2. For the Setup Transfer you have the possibility to forward a call or to set up a three-party confer-
ence.
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commands into CTI transactions of the XPR server. Communication is handled 
via the MSP, as is customary for the OpenScape Xpressions. However, a 
particularity is that the MSPTSP runs as TAPI service provider in the operating 
system's system context. Consequently, it cannot use the possibly already 
configured MSP user profiles because it is not authorized to access these data. 
So for the MSPTSP a separate user profile must be configured, which is valid for 
the computer the MSPTSP runs on. Of course, login via the Windows account is 
also impossible for this reason.

14.1  Installation

Setup copies the TSP files into the system directory and installs the TSP. In case 
the MSP has not been installed yet, the MSPTSP setup will install the MSP prior 
to the TSP setup.

14.2  Configuration

NOTE: The configuration is described for the Windows 2000 operating system. 
The description may slightly deviate for other Windows operating systems.

After the setup has been finished, the MSPTSP prompts you to start the program 
now. At this point you can directly perform the configuration. This is particularly 
advisable for inexperienced users. Otherwise, you can configure the MSPTSP 
later in the start menu under Settings > Control Panel > Phone and Modem 
Options on the Advanced tab under MSP TAPI Service Provider. The 
configuration of the MSPTSP can also be done via the MSPTSP icon on the 
desktop (as far as it has been created). You can also perform the configuration in 
the respective application (e. g. Microsoft Outlook). The different configuration 
possibilities will be described later on in the text.

You will see the following dialog by selecting Settings > Control Panel > Phone 
and Modem Options in the start menu. There, you can configure the TSP via the 
Dialing Rules and Advanced tab.
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You can configure your location settings on the Dialing Rules tab. Click on the 
New... button (as far as no location exists), and configure the corresponding 
settings on the General tab in the Edit Location dialog. Enter the Location 
name, Country/region, the Area code, the number to access an outside line 
for local calls and the number to access an outside line for long-distance 
calls. Then click Apply.

You can define rules for phone numbers of your own and of other area codes on 
the Area Code Rules tab. You can determine how phone numbers are to be 
called within your area code and outside. Click on the New... button in order to 
create a New Area Code Rule.
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Select the Advanced tab in the Start > Settings > Control Panel > Phone and 
Modem Options dialog. Select the MSP TAPI Service Provider entry and click 
on the Configure... button in order to define the server settings, user profiles and 
lines.

After a click on the Configure... button, the following dialog opens.
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The Server tab occurs first when the MSP has been unable to find an XPR server. 
The MSP already looks for existing servers during the installation and adds them 
to the list in the dialog at the right. If your XPR server does not appear in the list, 
add a new server by clicking the New… button.

Enter the network address or the name of the computer in the New server dialog, 
and search for the port number and the server via the Lookup button to avoid 
typing errors. Alternatively, you can enter it manually.

If an XPR server is already available, but no user profile has been configured, the 
User Profiles tab will be shown first.

Select the New… button in order to create a new user profile. As the MSPTSP 
runs in the system context, it cannot read existing user settings from an already 
installed MSP. Thus, a new user profile has to be created anyway. The 
corresponding configuration settings can be seen and changed in the MSPTSP 
as well as in the respective TAPI application.
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Create one or more user profiles on the User Profiles tab via New.... The Profile 
Name does not have to be entered, as it is generated automatically. Enter the 
User ID. This is necessary for logging on to the server. Enter the server name 
under Server. Afterwards, you save your password by activating the Remember 
Password check box. Enter your password and confirm it by entering it once 
again. Click the Add button afterwards.

NOTE: The Windows user account cannot be used for login since the MSPTSP 
runs in the system context.

You can enter the lines respectively the telephones you want to use on the Phone 
lines tab. Click the Add… button for this purpose. 

Telephone devices as well as lines can be added or deleted dynamically. Lines 
can be closed or opened as necessary.
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The Profile Name already exists. Enter the name of your extension under Name, 
e. g. Telephone 462. Enter the number of your extension under Number. The 
User Name and the ID will be generated automatically. Select the desired 
Speaker Mode. The speaker mode option always off means that the speaker is 
always off, independent from the settings performed in the TAPI application. 
Regular means that the speaker can be controlled by the TAPI application as far 
as the corresponding settings can be performed there. Always on means that the 
speaker is always on, independent from the settings performed in an attached 
TAPI application. We recommend the option always on, since most TAPI 
applications do not control the speaker mode. Click the Add button afterwards. 
The changes will become active at once.

NOTE: All changes will become at once active after clicking the Apply or OK 
button. The computer or the TAPI application need not be restarted.
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14.3  Error Search Logging

As is possible for all XPR server clients, you can use the logging tool for clients 
to create a log file also for the MSPTSP. In case of an error or whenever required 
you can then activate a logging. To create the log file, you need to execute the 
UnifiedLogTool.exe program on the client. This program must previously be 
copied to the appropriate client from the <XPR Install>\SDKTools folder. 

You find information about the client logging tool options in the XPR Server 
Administration manual.

14.4  Update

The automatical update of the MSPTSP via server is not supported up to now. 
Please make sure that the MSPTSP does not run anymore if you want to replace 
it by a newer version.

14.5  Uninstallation

The uninstallation wizard removes all providers that use the TSP. Afterwards the 
TSP files will be deleted from the system directory. Problems occur when the TSP 
cannot be deleted because it is being used by one or several TAPI applications. 
Therefore, make sure that no TAPI application is running when you want to 
remove the TSP.
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14.6  MSPTSP via Microsoft Outlook

To establish a phone connection from within Microsoft Outlook, select under 
Contacts one of the address entries you have specified. You will get into a 
context menu by a rightclick.

In this context menu select Call Contact.... Afterwards, click on the Start Call 
button. Your telephone rings and the connection to the corresponding party will 
be established.

Furthermore, you can dial a phone number that does not exist in the contact 
folder. A telephone icon  will appear when you open the contact folder. Click 
on the arrow on the right of the telephone icon to open a context menu. In there 
you find the menu items Redial, Speed Dialing3 and New Call... besides the 
entry of an existing contact. Click on New Call.... In the New Call... menu you can 
enter the desired phone number. Afterwards, click on Start Call. Alternatively, you 
may enter the shortcut key [Ctrl]+[Shift]+[D] in order to start a new phone call.

14.6.1  MSPTSP Configuration in Microsoft Outlook

The MSPTSP configuration can also be performed via Microsoft Outlook. 

1. Invoke the context menu with a rightclick on an address entry. 

2. Select the Call Contact... menu option. The New Call dialog opens.

3. Click on the Dialing Properties... button. Via the Dialing Rules tab you can 
perform the corresponding settings as described for the MSPTSP 
Configuration (see Section 14.2, “Configuration”, on page 116).

The Dialing Options are also available via the New Call dialog. The Line 
Properties can be entered here, as described in the MSPTSP Configuration, as 
well. Furthermore, you can configure the Dialing Properties.

You can make the configuration settings under Dialing Properties... > Dialing 
Rules > New... in the New Location dialog as in the MSPTSP Configuration 
dialog.

Right-click on a contact to open the contact menu Call Contact.... Subsequently 
click on Dialing Options > Line Properties.... There you will find configuration 
settings you can either perform under MSPTSP or under Microsoft Outlook. The 
Profile name is automatically generated. Enter the name (description) of your 
extension under Name, e.g. Telephone 100. Enter the number of your extension 
under Number. The User Name and the ID will be generated automatically. Then 
select a loudspeaker mode and click Save.

3. You can enter speed dialing numbers in the Dialing Options... dialog in Microsoft Outlook (Con-
tacts > Call Contacts... > Dial Options).
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15  Application Builder

The Application Builder is a program with a graphic editor that allows the user to 
assemble and configure a model of a voice dialog system (application model, 
application workflow) in the form of a call flow (block diagram or flow chart).

The flow chart consists of blocks and connections between these blocks. The flow 
chart blocks are controls that, for example, play a sound file, perform a database 
query or establish a phone connection to a subscriber. The connection lines 
between the controls in the flow chart indicate from which control a transition to 
another control is possible. Assembling means that the user determines which 
controls exist in the flow chart and which controls are interconnected. Configuring 
means that the user may set control properties. For example, he/she can set for 
a control to play sound files which sound files to play and in which sequence. The 
flow chart is - as described above - merely a model of a voice dialog system. 
Thus, it does not contain any information about the execution of the model in an 
application, e. g. how sound files are accessed and how these sound files are 
forwarded to a PBX so that a caller can listen to these files.

The result delivered by the Application Builder is a Java file, which represents a 
flow chart (application model, application workflow) with all of its control and 
connection properties. This file comprises the data which define an application 
and differ from other applications.

15.1  Application Builder Features

The Application Builder enables the easy creation of an interactive telephone 
application for your company. Synonyms for this are Automated Attendant, IVR 
(Interactive Voice Response), speech portal, voice server and voice dialog 
system. One or several phone numbers are assigned to such an application and 
when they are called, the following greeting may be played:

”Welcome to the XY company. If you would like to be connected to one of our 
assistants and know his/her extension, please push 1. If you would like to be 
connected with our hotline, please push 2. If you would...”

The Application Builder possesses among other things the following features:

• Creating and editing applications

– Chaining different applications

– Searching for specific characteristics and elements of all applications. For 
example, all applications that use a specific prompt can be put out. In 
case of a successful search, the results also deliver the prompt position 
within the application.

– Bookmarks for indicating the most different positions in the application
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– Integrating prompts in the respectively available languages

– Supporting text-to-speech for announcing text

– Using variables to store and forward data and information

– Creating statistic raw data for reporting usage

– Importing Application Generator applications used so far in the 
Application Builder

• Creating and modifying call flows that represent the possible functionality 
within an application

– Creating a call flow by drag & drop of controls within a clearly structured 
editor

– Customizing call flow views

– Attaching notes to a call flow

– The greatest possible graphic as well as functional flexibility when 
creating call flows

– Linking different call flows

• Controls: controls represent the smallest modules of a call flow

– Various controls are available for different functionalities

– Use of time profiles and time zones allows date- and time-dependent flow

– Flexible prompt playback possible

– Besides default settings, controls contain many configuration and linking 
options

– Use of TTS (text-to-speech) if licensed

• Language modification for GUI, documentation and online help after a 
program reboot
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Features of an Application
15.2  Features of an Application

An application created with the Application Builder may have the following 
features.

• Playing and re-recording of sound files

• Application-flow control by the caller using a menu and making entries via 
DTMF keys or voice

• Performing actions depending on date, weekday, national holidays and time 
considering the time zone

• Branching in the menu navigation depending on statistic as well as dynamic 
values such as the waiting loop allocation status

• Forwarding to an extension inclusive return call initiation

• Speech recognition

• Call recording

• Creating and applying call flow rules using specific conditions

• Definition and flexible use of variables

• Sending documents of different formats

• Searching for contacts

• Selecting a supported language

• Database query

• File access

• Starting instant-messaging systems

• Protection from infinite loops in the menu navigation

• Monitoring and statistic registration of an application execution via reporting

You find the detailed description of the Application Builder in the Application 
Builder manual.
A31003-S2370-U100-3-7619, 11/2013
OpenScape Xpressions V7 Client Applications, User Guide 127

          



Application Builder

Application_Builder.fm

Features of an Application
 A31003-S2370-U100-3-7619, 11/2013
128 OpenScape Xpressions V7 Client Applications, User Guide

         



Abkuerzungen.fm
Acronyms Y

This list contains the acronyms used in this manual.

Acronym Definition

BMP Image file format – bitmap graphic format by Microsoft

CTI Computer Telephony Integration – telephone control by PC

DCX Image file format – graphic format for fax by Microsoft

GSM Global System for Mobile Communications – cell phone standard

HTML Hypertext Markup Language

IM Integrated Messaging

IMAP Internet Message Access Protocol

IP Internet Protocol

IVR Interactive Voice Response – DTMF or voice-controlled telephone application.

JPG Graphics format of the Joint Photographic Experts Group

LDAP Lightweight Directory Access Protocol

PC Personal Computer

POP3 Post Office Protocol, protocol for polling messages from an Internet provider

SMS Short Message Service

SMTP Simple Mail Transfer Protocol, default Internet mail protocol

TAPI Telephone Application Programing Interface

TG3 Image file format – multi-page compressed TIFF fax format

TIF Image file format – Tagged Image File Format

TSP TAPI Service Provider

TTS Text To Speech, text to voice conversion

TUM True Unified Messaging

URL Uniform Resource Locator, unique Web address

VPN Virtual Private Network

WAV Acronym for wave format, data format for sound files

WWW World Wide Web
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Call forwarding 14
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Caller Guide

be connected 98
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E
e-mail 10
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F
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Fax editing
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Fax forms
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text object, color 76
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Firewall 110
Forward access 14

G
GSM 53
Guest access 15, 16, 17

I
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Inbox server 18

J
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L
Local database (cache) 109

M
Mailbox access 9
Microsoft Outlook 33
Microsoft Outlook (via Internet) 33
Microsoft Outlook Express 27
MS-Office 9
MSP TAPI Service Provider (MSPTSP) 115
MSP, Service Provider 109
MSPTSP

creating a log file 122
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N
Netscape Messenger 24
Number for call forwarding 14
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